Geometry Expressions™ Manual

Saltire Software
PO Box 230755
Tigard, OR 97281 0755
© 2013 Saltire Software. All rights reserved.

Information in this document is subject to change without notice. The distribution and sale of this product are intended for the use of the original purchaser only. Under the copyright laws, neither the documentation nor software may be copied, photocopied, reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part without the prior written consent of Saltire Software, Inc., except in the manner described in the Software License Agreement.

Saltire Software, Inc.
P.O. Box 230755
Tigard, OR 97281 0755
http://www.saltire.com
http://www.geometryexpressions.com

Geometry Expressions™ is a registered trademark of Saltire Software Inc.

This material is based upon work supported by the National Science Foundation under Grant No. 0750028
Table of Contents

Getting Started.................................................................................................................................11

Need Help?........................................................................................................................................11

Linked Text ........................................................................................................................................11

The Display and How It’s Organized.................................................................................................14

The Status Bar....................................................................................................................................15

Customizing Your Display..................................................................................................................18

Arranging Toolboxes............................................................................................................................19

Hiding / Showing Toolboxes................................................................................................................20

Saving the Configuration.......................................................................................................................21

Arranging Project Pages.......................................................................................................................22

Changing Background Color...............................................................................................................24

Adjusting the Default Settings............................................................................................................28

File Handling......................................................................................................................................32

Wookbooks and Individual .gx Files......................................................................................................33

MathML...............................................................................................................................................36

Some Opening Examples......................................................................................................................38

Tools ..................................................................................................................................................40
## Drawing

- Using the Drawing Tools ................................................. 40
- Adding a Point ................................................................. 41
- Adding Line Segments ................................................... 42
- Drawing Lines ................................................................. 43
- Drawing Vectors .............................................................. 44
- Drawing Polygons ............................................................ 45
- Drawing Circles .............................................................. 46
- Drawing Ellipses ............................................................. 47
- Drawing Parabolas ........................................................... 48
- Drawing Hyperbolas ........................................................ 49
- Drawing Arcs ................................................................. 50
- Drawing Regular Polygons ................................................ 55
- Drawing Curve Approximations ...................................... 56
- Adding Text to the Drawing ............................................. 57
- Using Pictures in the Drawing ......................................... 58
- Adding Expressions ....................................................... 60
- Creating Functions ......................................................... 61
- The Selection Arrow ...................................................... 72
- Adjusting the Drawing .................................................... 74

## Constraints ................................................................. 75

- Using Drawing Constraints ........................................... 75
- System Added Constraints ............................................. 78
- Constraint Conflicts ....................................................... 81
Contents

Distance / Length Constraint .................................................................83
Radius Constraint ..................................................................................84
Perpendicular Constraint ......................................................................84
Angle Constraint ..................................................................................85
Direction Constraint .............................................................................86
Slope Constraint ....................................................................................86
Coordinate Constraint ...........................................................................87
Constraining Vector Coefficients .........................................................87
Tangent Constraint ................................................................................88
Incident Constraint ...............................................................................88
Congruent Constraint ...........................................................................89
Parallel Constraint ...............................................................................90
Implicit Equation Constraint ...............................................................91
Point Proportional Along a Curve Constraint .......................................91

Constructions .........................................................................................96
Creating Constructions .........................................................................96
Midpoints of Line Segments .................................................................98
Intersections .........................................................................................98
Perpendicular Bisector .........................................................................99
Angle Bisector .....................................................................................100
Parallel Constructions .........................................................................100
Perpendicular Constructions ...............................................................101
Tangents ...............................................................................................101
Polygon Construction ...........................................................................102
Reflection ..............................................................................................102
Translation .................................................................103
Rotation ......................................................................103
Dilation ......................................................................104
Locus of Points / Envelope ...........................................105
Trace ..........................................................................107
Area Under the Arc .....................................................109
Annotations .................................................................111
Applying Annotations ..................................................111
Calculations .................................................................122
Calculating the Output ................................................122
Distance / Length Calculation ....................................124
Radius Calculation .....................................................124
Angle Calculation ......................................................125
Direction Calculation ...............................................127
Slope Calculation .......................................................127
Calculate Coordinates ...............................................128
Area Calculation .......................................................128
Perimeter Calculation ...............................................129
Calculate Coefficients .................................................129
Calculating Parametric Equations ..............................130
Calculating Implicit Equation ....................................130
Output ........................................................................131
Viewing the Output ....................................................131
Symbols .....................................................................136
Using Symbols .................................................................................................................................136
Inserting Greek Letters .....................................................................................................................137
Multiplication & Division Editing Tools ............................................................................................137
Square Root Editing Tool ..................................................................................................................138
Subscript / Superscript Editor .............................................................................................................138
Parentheses and Absolute Value Notation .........................................................................................139
Using the Piecewise Function ...........................................................................................................139

Built-In Functions ............................................................................................................................139

Using Annotation Symbols ................................................................................................................140

System Variables and Animation ........................................................................................................142

Investigating Variables ......................................................................................................................143
Variables List .....................................................................................................................................144
Functions List .....................................................................................................................................144
Using the Lock Tool ..........................................................................................................................145
Changing and Locking the Variable Value .........................................................................................147
Animation ...........................................................................................................................................147
Animation Console ............................................................................................................................149
Animation Modes ..............................................................................................................................149
Animation Values and Duration ..........................................................................................................149
Animation and the Locus Tool ............................................................................................................150

Menus and Icons ...............................................................................................................................152

File Menu ...........................................................................................................................................152
Importing Files from the Figure Gallery ..............................................................................................153
Need Help?

There are many ways to get help with Geometry Expressions.

In both the PDF manual document and the embedded Help system you can:

- Use the table of contents to get details on using a tool, an icon or a menu.
- Use the index for help on a particular topic, such as "parametric equations".

Inside the *Geometry Expressions* Help system you can:

- Use the Search tool to find all topics based on a key word, such as "constraints".
- Browse through help with the up - "Previous page", and down - "Next Page" arrows . This will step you through the help subtopics in a logical sequence.
- You can click on colored text which links you to more information.

**Tool Tips:**
When you move the cursor over any icon on the screen, the name of the icon appears briefly below the cursor.

**Linked Text**

Some words in the program's Help system are highlighted and underlined. When you place the cursor over this text, the cursor becomes the hand symbol. This text indicates a link to more information on the subject. Click the text to jump to the related help page.
The Display and How It’s Organized
Many of the menu items in the drop down menu bar at the top of the screen correspond to one of the icons or buttons across the top of the display window or in one of the toolboxes.

Icons across the top of the screen comprise the standard Windows **File**, **Edit**, **View** and **Help** commands. The construction and calculation tools are displayed along the side of the drawing window. These toolboxes can be displayed on the left or right panel, top or bottom panel, floating in a separate window, or hidden.

The **Output** window can be displayed below the drawing window to show large expressions.

The status bar at the bottom of the window displays the following (from left to right):

<Menu Help> <Current Mode> <Cursor Coordinates> <Angle Mode>
The Status Bar

The status bar at the bottom of the screen prompts the following information (from left to right):

- **Menu Help** - summary of a selected menu item.
- **Current Mode** - Each icon in the drawing toolbox represents a mode. Tools requiring additional inputs after clicking the tool will display further prompts in this field.
- **Cursor Coordinates** - Displays the current coordinates of the cursor in the diagram.
- **Angle Mode** - A drop down window for conveniently changing from Radians to Degrees and *visa versa*. This default can also be changed in the Preferences dialog - *Edit / Preferences / Math*.
Customizing Your Display
You can arrange the display as it suits you.

**Arranging Toolboxes** - Anchored or floating toolboxes can be placed around the drawing window.

**Hide / Show Toolboxes** - You may want to hide toolboxes which you rarely use.

**Saving your configuration** - Use the View / Tool Panel Configurations.

**Arranging projects** - You can open multiple project files and arrange them in the drawing window using the page tabs.

In the example below three toolboxes (Draw, Constrain (Input), and Construct) are anchored, two (Calculate (Output) and Variables) are floating, and three (Annotate, Symbols, and Annotation Symbols) are hidden. Two slightly different locus examples are displayed for comparison.
Arranging Toolboxes

You can move the toolboxes around the periphery of the drawing window by clicking the title bar and dragging.

Click the pushpin on the upper right corner of individual toolboxes to make it a "floating" box that you can drag anywhere on the screen. Floating boxes have a colored title bar -
To re-anchor the toolbox, drag the box until a blue shadow appears at the position where you want it, then release the mouse button. You may want to readjust the screen size for optimal viewing.

**Hiding / Showing Toolboxes**

Use the X on the upper right corner of individual toolboxes to hide them.

To display a hidden toolbox, select **View / Tool Panels**. The submenu lists the toolboxes and the **Main Toolbar** (the icon strip at the top of the window). Boxes shown are preceded by a check, those without a check are hidden.
Click a toolbox name to change its state.

**Saving the Configuration**

After configuring the screen to your preference, you can save this arrangement in case it gets messed up, or perhaps you need the tools arranged differently for different projects. This is easy with the **View / Tool Panel Configurations** menu selection. You can give a name to an arrangement of the toolbars. Several configurations can be saved in a list and referred to as needed.

**Add** - to save the current screen configuration. You will be prompted for a name to reference this configuration.

**Delete** - if you no longer will use a certain configuration you can delete it from your list.

**Set** - to change a configuration which you have saved, simply select the configuration name from your list. Check out the configurations that come with the program.
Default - reset tool panels back to the default configuration.

Arranging Project Pages

You can open multiple project files for quick reference. By default files are overlaid. Click a page tab to bring a file to the top.

Comparing drawings side by side - click the page tab and drag it to one side, top, or bottom of the window. A shadow of the drawing gives you an indication of how the drawings will be arranged before you release the mouse button.
Returning to overlaid configuration - drag one tab and position it over the other tab. The shadow will appear only on the title bar, then release the mouse button.
Changing Background Color

You can now change the drawing's background color to something other than white by the following steps:

1. Select **Edit / Preferences...** (or in the Mac version, **Geometry Expressions / Preferences...**)
2. Click **Grid, Axis, Page** button
3. Change **Fill Color** in **Background** section. The color will be applied to all pages.
Adjusting the Default Settings
Select **Preferences** from the **Edit** menu (or in the Mac version, **Geometry Expressions / Preferences...**) to modify the program's defaults.

The default settings are grouped by type, listed on the left side of the **Preferences** dialog. Click the icon to display the desired page.

These settings are also available for editing a selected object or group of objects individually without changing the defaults, using the Selection Context Menu.
<table>
<thead>
<tr>
<th>Selection</th>
<th>set the line color and style for each selection type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometry</td>
<td>set font related properties for labels; color and size/style for other geometric elements.</td>
</tr>
<tr>
<td>Text &amp; Pictures</td>
<td>set font properties for text, the rotation angle and the transparency level of an inserted picture, and the <strong>Pinned</strong> state for <strong>Text</strong> and <strong>Pictures</strong>. Pinned <strong>Text</strong> and <strong>Pictures</strong> will not move relative to the <strong>Page Boundaries</strong> as the result of a <strong>Scale</strong> operation.</td>
</tr>
<tr>
<td>Math</td>
<td>set the properties for alphanumeric input and output; mathematical calculation defaults.</td>
</tr>
<tr>
<td>Grid, Axis, Page</td>
<td>set properties of the Major and Minor Grid, the coordinate Axes, the drawing’s background color, and the Page Boundary lines.</td>
</tr>
</tbody>
</table>

To see the possible values for each property, click the row. An icon will appear at the right end of the row (except the **Point Size** selection under the **Font** property - you can enter the point size directly).

<table>
<thead>
<tr>
<th>Math</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle Mode</td>
</tr>
<tr>
<td>Intermediate Variable Complexity (2 to 100)</td>
</tr>
<tr>
<td>Precision Type</td>
</tr>
<tr>
<td>Decimal Digits (0 to 8)</td>
</tr>
</tbody>
</table>

Click the icon to display the selection dialog or drop-down menu of choices.

<table>
<thead>
<tr>
<th>Math</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle Mode</td>
</tr>
<tr>
<td>Intermediate Variable Complexity (2 to 100)</td>
</tr>
<tr>
<td>Precision Type</td>
</tr>
<tr>
<td>Decimal Digits (0 to 8)</td>
</tr>
</tbody>
</table>

Changing a default for a type of drawing entity will apply to all entities of
that type except ones whose properties have been individually set, by selecting it and then choosing **Edit / Properties** or right clicking **All Properties** from the **Selection Context** menu. Likewise, text, pictures or expressions that were individually pinned or unpinned will not be affected by changes to the default **Pinned** settings.
File Handling
Geometry Expressions uses standard Windows file Open and Save operations. Save your files regularly with the handy icon at the top of the screen.

The data files generated from your drawings will have the extension ".gx".

You may create multiple data files and have them open in a session. Each file is on separate page with the tabs across the top of the drawing window. Click the tab to view the file.

If you are preparing a multi-paged lesson, you can save the pages together as a Workbook, with the file extension ".gxw". This is a completely separate file from the .gx files.

The Open / Save (As) / Close Workbook file selections apply only to the workbook. and the File / Save commands will NOT save the workbook files. They only affect the individual .gx files.

Files can also be arranged for comparison viewing.
Wookbooks and Individual .gx Files

Workbooks are a handy way of putting lessons together.

- You can make a workbook by opening new tabs (File / New).
- You can Open .gx files that you have already created to make them part of your workbook.
- You can create pages from a combination of the above.

When all of the pages are together on the page tab bar, select Save.
Workbook (As) from the file menu.

⚠️ Note: saving the workbook does NOT update any of the individual .gx files displayed in the workbook, since the workbook file is an entirely separate file (.gxw). If you want to keep the individual .gx file up to date with the workbook page, you must use the regular File / Save for each page / file. But, if you forget, you can always save it from the workbook at any time.

Likewise, saving an individual page, File / Save, of an open workbook does NOT update the workbook file (.gxw). However, if you forget to save the workbook, but save a page (.gx), you can always open the .gx file again from your open workbook file and resave the workbook.

If you don't want to keep individual copies of all your workbook pages, then you just have to remember to use the Save Workbook file selection.

However, to give the workbook pages custom names (instead of unnamed7.gx), you must save the individual page (for example, Lesson 1 Ellipse.gx) at least once. After the first time, you don't need to continue to save the .gx file.

Only one workbook file can be open at a time. If you open a workbook file while other individual files or another workbook file is open, they will be closed, after, of course, prompting you to save them if you have made changes.
All mathematical expressions in *Geometry Expressions* are written in *MathML*, so you can copy and paste directly to or from any other *MathML* program.

Usually the standard **Edit / Copy** or Ctrl-C command should work. If this doesn't give you the desired result, try the **Edit / Copy As** command. Select from the submenu of choices appropriate to your application.

If you copy an expression that uses Intermediate Variables, the algebra system will create a function from the pasted expression.

To **Paste** math into *Geometry Expressions* it must be *Content MathML*.

- *Maple* creates *Content MathML* by default.

- To create *Content MathML* in *Mathematica v6.0*, execute the following commands:
  
  ```mathematica
  SetOptions/XML`MathML`ExpressionToMathML,"NamespacePrefixes" -> {}, "Formats" -> {"ContentMathML"}
  
  SetOptions/XML`MathML`BoxesToMathML,"NamespacePrefixes" -> {}, "Formats" -> {"ContentMathML"}
  
  SetOptions[Export, ConversionOptions -> {"NamespacePrefixes" -> {}, "Formats" -> {"ContentMathML"}}]
  
  SetOptions[ExportString, ConversionOptions -> {"NamespacePrefixes" -> {}, "Formats" -> {"ContentMathML"}}]
  ```
Some Opening Examples
Your installation comes with several examples - look in the Examples subdirectory. For step by step instructions through some example sets, see the Geometry Expressions Tutorial.pdf and Geometry Expressions Examples.pdf which can be found under the Doc subdirectory in your Gx installation.
Tools
Drawing

Using the Drawing Tools

The **Draw** toolbox contains the drawing commands and the Selection Arrow. The drawing commands can also be invoked from the **Draw** menu.

Unlike commands in the other toolboxes, Drawing commands are always available and require no pre-selection. Many of the commands are active until you change to a different one or press the **Esc** key or click the selection arrow, e.g. you can make multiple points until you select another tool or press esc. The selection mode, indicated by the selection arrow cursor, is used for invoking all other commands. You can find the active command mode by noting which button is pressed or looking at the current mode on the status bar.
Before you start your drawing, select **Edit / Preferences / Geometry** to set various attributes, such as line color / style, fill color / style and transparency level, of the various drawing elements.

You can change the attributes of individual drawing elements by selecting them, right click the mouse, and choose **All Properties** from the context menu.

**Adding a Point**

To insert a point in your drawing, follow these steps:

1. Click the **Point** icon in the **Drawing** toolbox or select **Point** from the **Draw** menu.

2. Move the crosshairs into position.

3. Click the mouse to place the point under the crosshair.

When the crosshairs are positioned over some geometry an incidence symbol (bowtie) is displayed around the point and the geometry is highlighted. A click of the mouse will create the point incident to the highlighted geometry.
Each point is displayed with a letter label. You can change the label from the Select mode \( \rightarrow \).

**Point** is a modal command. You can continue making points until you choose the select arrow or another drawing tool.

**Adding Line Segments**

To add line segments to your geometry follow these steps:

1. Click on the **Line Segment** icon \( \square \) in the **Draw** toolbox or select **Line Segment** from the **Draw** menu.

2. Position the cursor \( \rightarrow \) in the drawing window.

3. Click the mouse to place each endpoint.

Each line segment is displayed with a letter label for each endpoint.

You can change the label from the Select mode \( \rightarrow \).

To abort a line segment in the middle of the drawing operation, hit the "esc" key.

**Line Segment** is a modal command. You can continue making segments until you choose the select arrow or another drawing tool.
Drawing Lines

Lines are similar to line segments except they have infinite length.

1. Click the **Infinite Line** icon in the **Draw** toolbox or select **Infinite Line** from the **Draw** menu.

2. Position the line cursor in the drawing window.

3. Click the cursor to anchor the line at the cursor position. The anchor point will be displayed on the line.

4. Move the cursor in the drawing window to position the line and click the cursor when you get the line in the desired orientation.

**Lines** are infinite and do not have points associated with them unless you specifically place one on the line.

**Line** is a modal command. You can continue making lines until you choose the select arrow or another drawing tool.

**Active Axes** -

The x and y axes have the properties of perpendicular infinite lines. When the crosshairs are positioned over an axis, the incidence symbol (bow tie) is displayed at the intersection and the axis is highlighted.
the cursor is at the origin, both axes are highlighted. Points and End points of line segments can be placed directly on the axes without using the **Constrain / Incident** tool when the bow tie is displayed.

### Drawing Vectors

To add vectors to your geometry follow these steps:

1. Click the **Vector** icon in the **Draw** toolbox or select **Vector** from the **Draw** menu.

2. Position the cursor in the drawing window.

3. Click the mouse to place each endpoint.

Each vector is displayed with a letter label for each endpoint.

Drawing vectors is similar to drawing line segments, but vectors are constrained with coefficients of the form:

![Vector Diagram](image)

Vector is a modal command. You can continue making vectors until you choose the select arrow or another drawing tool.
Drawing Polygons

You can quickly create a multisided figure with these steps:

1. Click the **Polygon** icon in the **Draw** toolbox or select **Polygon** from the **Draw** menu.

2. Position the cursor in the drawing window.

3. Move the cursor and click once to place each vertex.
   - As you create the sides of the polygon, each vertex is automatically assigned a letter name. You can change the label in **Select** mode.
   - When you create the last side of the polygon by clicking on the first vertex, the polygon will be filled with the default fill color, style and transparency.
   - To change the appearance of the polygon (color or style), select it, right click, and choose **All Properties** from the context menu.
   - **Polygon** is a modal command. You can continue making polygons until you choose the select arrow or another drawing tool.

Polygons can be filled with the color, style, and transparency level of your choice. See the **Edit / Preferences** menu, **Geometry** tab to set the default. To change the color / style /transparency level of selected polygons, select the polygon(s), right-click, and select **All Properties** from the Selection Context menu (or **Edit / Properties** from the menu bar).
Drawing Circles

To add a circle to your diagram, follow these steps:

1. Click the **Circle** icon in the **Draw** toolbox or select **Circle** from the **Draw** menu.

2. Move the cursor in the drawing window to the position of the center of the circle and click once.

3. Move the cursor to draw the circle in the desired size and click again.

Notice the circle is displayed with 2 points, the center and a point on the perimeter.

**Circle** is a modal command. You can continue making circles until you choose the select arrow or another drawing tool.

You can adjust the circle in Select mode.

Circles can be filled with the color / transparency level of your choice. See the **Edit / Preferences** menu, **Geometry** tab to set the default. To change the color / transparency level of selected circles, select the circle (s), right-click, and select **All Properties** from the selection context menu (or **Edit / Properties** from the menu bar).
Drawing Ellipses

To create an ellipse in your diagram, follow these steps:

1. Click the Ellipse icon in the Draw toolbox or select Ellipse from the Draw menu.

2. Move the cursor in the drawing window to the position of one focal point. Click to place the first focus point. Move the cursor and click again to place the second focal point.

3. Then move the cursor to open the ellipse to the desired shape and click the mouse a third time.

The ellipse will appear with three labeled points, the two foci and a point on the ellipse.

The Ellipse tool is a modal command. You can continue making ellipses until you choose the select arrow or another drawing tool.

Ellipses can be filled with the color / transparency level of your choice. See the Edit / Preferences menu, Geometry tab, Conic properties group to set the default. To change the color / transparency level of selected ellipses, select the ellipse(s), right-click, and select All Properties from the selection context menu (or Edit / Properties from the menu bar).
Drawing Parabolas

To create a parabola in your diagram, follow these steps:

1. Click the Parabola icon in the Draw toolbox or select Parabola from the Draw menu.

2. Move the cursor in the drawing window to the position of the parabola's vertex. Click and drag the mouse along the major axis. Release the mouse at the focus.

After sketching the general parabola, you can constrain it in the following ways:

1. Click the parabola and select Implicit equation from the Constrain toolbox and type or paste the formula.

2. Constrain the vertex and focus points to some coordinate values.
3. You can also adjust the parabola with the Translation, Rotation and Dilation tools.

**Drawing Hyperbolas**

To create a hyperbola in your diagram, follow these steps:

1. Click the **Hyperbola** icon in the **Draw** toolbox or select **Hyperbola** from the **Draw** menu.

2. Move the cursor in the drawing window to the position of one focal point. Click to place the first focus. Move the cursor and click again to place the second focal point.

3. Then move the cursor to open the hyperbola to the desired shape and click the mouse a third time.
The hyperbola will appear with three labeled points, the two foci and a point on the hyperbola.

The **Hyperbola** tool is a modal command. You can continue making hyperbolas until you choose the select arrow or another drawing tool.

**Drawing Arcs**

Arcs can be placed on any of the conics - circle, ellipse, parabola, hyperbola - or any function. Points are automatically placed at the ends of the arc.

Here are the steps:

1. First draw the conic or function which will be the basis for the arc.

2. Choose the Arc tool and move the cursor over the section of the existing curve where the arc will be defined. Click and drag the cursor over the curve.
Endpoints are automatically inserted on the arc.

**Curvilinear Polygons**

The **Arc** drawing tool lets you make curvilinear polygons for which you can assign fill properties and find areas. There are some limitations, however. Since you can't construct a point on two intersecting curves (except for circles), you have to connect curves with line segments. If you want to connect two arcs, you have to first connect them with a line and move it to the intersection like this:
To make a curvilinear polygon of the intersecting parabolas here are the steps:

- Attach two lines.
- Make endpoints C and D \(-t\) point proportional along the curves.
- Make endpoints A and B \(t\) point proportional along the curves.
- Draw the two arcs - select **Draw / Arc**, from C to A and D to B.
- Select the sides and arcs of the polygon in order and click **Construct / Polygon**.
- Set \(t=2\) in the **Variables** toolbox and the lines will become the intersection points.
It's easier with circles because you can place points on their intersections:
Drawing Regular Polygons

The **N-gon** tool lets you quickly draw any regular polygon. You can even work on problems where the number of sides is \( n \), or whatever variable you choose.

Here are the steps:

1. Click the N-gon button \( \text{\includegraphics[width=1cm]{icons/n-gon.png}} \) in the Draw toolbox.

2. Similar to drawing a circle, position the cursor to place the center of the n-gon and click to the desired size. The n-gon at first appears to be a pentagon.

3. In the data entry box, enter the number of sides you want or a variable to represent the number of sides and press Enter.
Drawing Curve Approximations

The **Curve Approximation** tool will insert a specified number of points and edges evenly spaced on a selected section of a curve or conic. This is a great tool for introducing problems using the Trapezoidal Method of integration. (Take a look at our Gx book, Calculus Explorations.)

Here are the steps:

1. Click Draw / Curve Approximation.
2. Select any function, circle, ellipse or parabola and drag the cursor over the curve.
3. In the data entry box type the number of points you want on the arc.

**Note:** It is best to draw your curve independent of existing points on the curve. Then connect other geometry to the approximation points. If you start or finish the arc with points lying on the curve (e.g. point C in the ellipse above) and later decide to delete the curve approximation, attached geometry may also get deleted.
Here is the area of a function using the Trapezoidal Method:

\[
\frac{a \cdot t^3 \cdot (1+2 \cdot n^2)}{6 \cdot n^2}
\]

---

**Adding Text to the Drawing**

To add titles or other annotation to the drawing follow these steps:

1. From the **Draw** toolbox click the **Text** icon or select **Text** from the **Draw** menu.

2. Position the text cursor at the upper left corner where you would like your window of text located.

3. Click and drag to form your text box to the appropriate size.
4. Enter and format your text in the Edit Text dialog.

Enter mathematical statements using the **Annotation / Expression** tool.

**Inserting and Editing Text**

In the **Edit Text** dialog you can enter and format the text that will be displayed in your defined text window.

![Edit Text dialog]

The default text formatting for this dialog is set in **Edit / Preferences / Text & Pictures**.

**Using Pictures in the Drawing**

Liven up your examples with a picture or two, or use an image for reference points in your drawing. Here's how:
1. Click the **Picture** icon in the **Draw** toolbox or select **Picture** from the **Draw** menu.

2. Click and drag the cursor to delimit the area where you want to place the picture.


4. After entering your images, change to **Select** mode or choose another **Draw** command.

Pictures are always inserted under your drawing objects, so you can add a picture at any time.

In **Select** mode you can move a picture, as with any drawing object. The inserted picture can be rotated and the transparency level can be set in the **Display Properties** dialog box.

- Right click on a highlighted picture and then select **All Properties**
- Or select **Properties** from **Edit** menu.
Adding Expressions

You can type an algebraic expression in the drawing window and Geometry Expressions will solve it with whatever information it has available. Here are the steps:

1. From the Draw toolbox click the Expression icon or select Expression from the Draw menu.

2. Move the expression cursor to the position where you want it to appear in the drawing window and click to display the data entry box.

3. Enter the expression using numbers, variables, and output expression names. Use the Symbols toolbox to help you enter mathematics.

Adding an expression to the diagram can help you work out relationships in the geometry. Here is an example making use of the Expression tool to see the relationship between similar triangles.
Sides $a$ and $b$ are perpendicular, and $AC$ is perpendicular to $BD$. We obtained the Output of lengths $AD$ and $BD$ using the Show Name button.

The expression to solve is the relationship of the two lengths: $z_0 / z_1$. The system immediately evaluates the expression as $=> a/b$.

**Creating Functions**

1. Click the **Function** icon in the **Draw** toolbox or select **Function** from the **Draw** menu.

2. Click the drop-down list button to select the function type that you want to use in your drawing.
Cartesian Function

When you select Cartesian from the Function Type dialog, the next line contains a general form of the function in terms of Y.

You can define a domain of the function by enter values for Start and End. If you want to draw function with indefinite domain, leave these fields blank.

You can define this function in these ways:
- Modify the formula directly:
Modify the function interactively using "handles". In the drawing window, click the function to select it. Click and drag it and a circle appears on the curve. This handle represents one of the variables in the equation. You can click and drag this handle around the drawing. Click and drag another place on the function and another moveable handle appears if there is another variable in the equation.

This feature is a wonderful way to understand exactly how the equation represents the function.

In the first example, a click of the curve gives you the $b$ handle, the $y$-intercept, and lets you drag the function up and down. Click and drag another place on the curve and you get the $a$ handle to change the shape of the curve.

Notice the **Variable** toolbox displays the changing values as you move the handles.

- Modify the function after it's drawn by double clicking the function tag and changing it in the edit box.
- Modify the domain of the function after it's drawn by double clicking the curve.
The Generic Function f(X)

To use the generic form of a function, Y=f(X), select **Cartesian** from the **Function Type** dialog, enter f(X) in the edit window and click **OK**:

Click the **Functions** tab of the **Variables** toolbox to see the values used in the function.

You can define this function in these ways:

- Modify the edit line at the bottom of the **Functions** tab. (Use your keyboard arrow keys to move through the whole function.)

- Modify the function interactively using "handles". In the drawing window, click the function to select it. Click and drag it and a circle appears on the curve. This handle represents one of the variables in the equation. You can click and drag a handle around the drawing to change the curve. Click and drag another place on the curve and another moveable handle appears if there is another function variable in the equation. In the general function in this example we have 5 possible handles: f(a), f(b), f(k), f(u), and f(v).
Polar Function

When you select Polar from the Function Type dialog, the next line contains the general form of the function in terms of the radial coordinate, r and the polar angle, T.

You can define this function in these ways:
- Modify the formula and the curve domain directly:
Modify the function interactively using "handles". In the drawing window, click the function to select it. Click and drag it and a circle appears on the curve. This handle represents one of the variables in the equation. You can click and drag this handle around the drawing. Click and drag another place on the function and another moveable handle appears if there is another variable in the equation.

This feature is a wonderful way to understand exactly how the equation represents the function.

In the example above, the second click gives you the $a$ handle; click and drag another place on the curve and you get the $b$ handle to change the shape of the curve.

Notice the **Variable** toolbox displays the changing values as you move the handles.

- Modify the function after it's drawn by double clicking the function tag.
- Modify the domain of the function after it's drawn by double clicking the curve:
**Parametric Function**

When you select **Parametric** from the **Function Type** dialog, the next line contains the general form of the function in terms of X and Y and a parameter, T.

You can define this function in these ways:
- Modify the formula and its domain directly:
- Modify the function interactively using "handles". In the drawing window, click the function to select it. Click and drag it and a circle appears on the curve. This handle represents one of the variables in the equation. You can click and drag this handle around the drawing. Click and drag another place on the function and another moveable handle appears if there is another variable in the equation.

This feature is a wonderful way to understand exactly how the equation represents the function.

In the example above, $X=T-a\sin(T)$, $Y=b-\cos(T)$, a click and drag gives you the $b$ handle, and lets you drag the function up and down. Click and drag another place on the curve and you get the $a$ handle to change the shape of the curve.

Notice the **Variable** toolbox displays the changing values as you move the handles.

- Modify the function after it's drawn by double clicking the function tag.
- Modify the domain of the function after it's drawn by double clicking the curve:
**Piecewise Function**

A piecewise function or expression can be created using the **Piecewise** symbol:

\[
\begin{align*}
X &= T - \alpha \sin(T) \\
Y &= \beta - \cos(T)
\end{align*}
\]

or the built-in function - `piecewise({expression1, domain1},{expression2, domain2}..., {last expression, otherwise})`. The reserved word, "otherwise" is an option available for the last condition.

Here we show how to enter the sequence of values, followed by conditions:

- Create a function.
- Double click the equation to edit.
• From the edit box click the **Piecewise** icon in the **Symbols** toolbox. Four small gray boxes will appear, including the one containing the original equation.

• Fill in your piecewise parameters - equations in the left column and their domain in the right column. To expand the function, click the **Piecewise** icon again for an additional row.

Here's the finished piecewise function:

\[
Y = \begin{cases} 
  a + X^2 & X < -1 \\
  2a & -1 \leq X \text{ and } X \leq 1 \\
  a + X^2 & X > 1 
\end{cases}
\]

**Piecewise Parametric Example**

Any of the functions available in *Geometry Expressions* can be piecewise, including parametric functions. Take this square for example.

1. Click the **Draw / Function** tool 📒.
2. Select **Parametric** from the drop down **Type** window.

3. Enter the first value (side) for the square and the range for the parameter values - Hit enter. Don't worry about the shape of the function, it's not defined yet.

4. Double-click the function and select the x value

5. Click the **Piecewise** icon

6. Enter the x values for each side of the square. When you run out of gray boxes, click the **Piecewise** icon again to get another row.
7. Now do the same for the y value, select the T parameter and click the **Piecewise** icon 3 times -

Use the arrow keys on your keyboard or your mouse to move to the next gray box.

Here is the function:

![Function Diagram]

**The Selection Arrow**

When you are finished with the drawing functions, click the selection arrow to enable other functions or adjust your drawing.

With the arrow, you must first select elements of the drawing in order to enter constraints and constructions and to output calculations.

Many of the tools require you to select multiple objects.

The **Selection** arrow is also available from the icon bar at the top of the
Selecting Multiple Objects

Many of the **Constrain**, **Construct**, and **Calculate** tools require that you select more than one object.

To select more than one object:

- Click the selection arrow on the tool bar.
- Hold down the CTRL or SHIFT key as you click the objects you want to select.

If you click the wrong object while holding down the CTRL key, click it again and it will become unselected.

If all of the objects you wish to select fall within a rectangular region, you can use the selection box:

- Click on the selection arrow on the tool bar or the **Drawing** toolbox.
- Draw a rectangle around all of the objects by clicking and dragging.

If you are using *Geometry Expressions* on a **Smartboard**, turn on Smartboard mode to make multiple selections without using the **Ctrl** or **Shift** keys. In this mode selections accumulate. Clicking a blank space in the drawing does not clear the selections. Clicking on an item a second time unselects only that item.
Smartboard Mode

To turn on the Smartboard mode select Edit / Preferences / Selection; in the Selection group set Smartboard mode to True.

When set to True, selections accumulate until you click a command. Clicking a selected item a second time unselects that item, but any other selected items stay selected. To clear all the selections, select Clear Selection under the Edit menu or click all the selected objects again.

Adjusting the Drawing

Click the Select arrow, either from the Drawing toolbox or the icon bar, to move, rotate or delete selected object(s) in the drawing.

You can change a constraint value, annotation or label by double clicking it, retyping the value or variable and then pressing the enter key.

The Scale, Zoom and Move / Pan functions have a mouse shortcut:

- The scroll wheel on your mouse can be used to Scale the drawing up or down. Hold down the ctrl key while moving the wheel and the operation becomes a Zoom.

- Right-click and drag the mouse anywhere in the drawing window to Move or Pan.

The Move geometry icon is a modal command. It stays active until you select or choose another mode (e.g. any Draw tool).
Constraints

Using Drawing Constraints

After sketching the geometry of a problem, constrain it with measurements, coordinates and implicit equations in real or symbolic terms. The drawing responds automatically to the assigned input constraints. *Geometry Expressions* will automatically add any constraints you leave out.

Since annotations may look identical to constraints, use the icon, ![Annotation Icon](https://www.example.com/annotation-icon.png), to **Distinguish Constraints / Annotations**. The icon is a toggle; to turn off the marks, click it again.

Initially, all the constraints in the toolbox are inactive. You must first select the parts for your drawing that will be constrained. Constraint choices are listed below along with the drawing elements that must be preselected. Be careful when selecting geometry objects, if extra things are selected that are not related to the constraint (like other constraints) the constraints will remain inactive. This can happen by mistake, especially when using the selection box tool.

<table>
<thead>
<tr>
<th>Constraint</th>
<th>Preselected Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="https://www.example.com/distance-icon.png" alt="Distance Icon" /></td>
<td>Distance / Length Two of any combination of points, lines, line segments, vectors, or polygon sides.</td>
</tr>
<tr>
<td><img src="https://www.example.com/radius-icon.png" alt="Radius Icon" /></td>
<td>Radius A circle</td>
</tr>
<tr>
<td><img src="https://www.example.com/perpendicular-icon.png" alt="Perpendicular Icon" /></td>
<td>Perpendicular Two of any lines, segments, vectors, or polygon sides.</td>
</tr>
<tr>
<td>Constraint</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Angle</td>
<td>Two of any lines, segments, vectors, or polygon sides.</td>
</tr>
<tr>
<td>Direction</td>
<td>A line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Slope</td>
<td>A line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Coordinate</td>
<td>A point</td>
</tr>
<tr>
<td>Coefficients</td>
<td>A vector</td>
</tr>
<tr>
<td>Tangent</td>
<td>A circle or locus and a line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Incident</td>
<td>A point and a line, segment, vector, polygon side, circle or locus.</td>
</tr>
<tr>
<td>Congruent</td>
<td>Two or three of any line segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Parallel</td>
<td>Two or three of any line segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Implicit Equation</td>
<td>A circle, line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Point Proportional Along Curve</td>
<td>A point and a line, segment, vector, polygon side, or locus</td>
</tr>
</tbody>
</table>

Occasionally you may try to add too many constraints to the geometry, causing a conflict. The system will help you correct this problem in the Resolve Constraint Conflict dialog.
Changing a Constraint

To change a constraint, double click it with the selection arrow, retype the value or variable and press the enter key.

Distinguishing Constraints from Annotations

Your drawing is defined by Constraints on geometry elements. Annotations are like labels and have no influence on the geometry measurements. The original default settings (Preferences / Math) fix Constraint lines and text in blue and Annotation lines and text in black. To further distinguish these use the Distinguish Constraints / Annotations toggle button on the main icon bar.

When active, the button is highlighted - , and a is placed next to all constraints and a is placed next to all annotations. As with all toggles, you can turn these marks off with another click of the button.
System Added Constraints

In *Geometry Expressions*, you do not need to fully constrain your model. Any parameters you have left unconstrained are filled in by the geometry engine.

For example, the following drawing is constrained only modulo a rigid transformation (typical for many geometry problems).

So if you ask for the coordinates of any of the points, they will be given in terms of system added variables:
Clearly the system has added variables for the location of point A, and for the direction of line AC.

To display these variables, check the default setting, Show System Variables, found in the Edit / Preferences menu selection on the Math page (left panel) under Output.
When the setting is **True**, you will see the system variables when you select the output:
Constraint Conflicts

If you enter a constraint for some geometry which is already constrained by another constrained object you will see a message like the one below.

The new coordinate constraint tries to move items that are already fixed by other constraints.

- Discard the coordinate
- Calculate the coordinate from other constraints
- Relax other constraints so the coordinate is independent

Click on the constraints to be relaxed

- Conflicting Constraints: 0
- Constraints Relaxed: 1
- The coordinate to be added

In this case, the Coordinate constraint was already determined by the other two sides and an angle constraint on the triangle. There are three ways of dealing with this problem:

1. Hit the Cancel button to leave the drawing as it was without the new
2. Click the first button, "Calculate the coordinates from other constraints" (the default choice). This is similar to the first choice, it eliminates the new constraint, but also calculates the selected geometry’s value. In this case, the coordinates of point C would be calculated and displayed.

3. If you choose "Relax other constraints so the coordinate is independent", this will keep the new constraint you just entered and allow you to eliminate one of the red highlighted constraints (figure 1). When you select one of these constraints (in figure 2 below we clicked on \( q \)), the highlight changes to gray. After you click Ok, the selected constraint, the angle \( \theta \) in this case, is calculated and displayed (figure 3).

![Figure 1](image1.png)

![Figure 2](image2.png)
Distance / Length Constraint

The **Distance / Length** constraint lets you specify the following dimensions:

- Length of a line segment, vector, or polygon side
- Distance between two points or a point and any one of the line types listed above.
- To enter a constraint:

1. Select the appropriate drawing object(s). When you make your selection, the **Distance / Length** icon will light up.
2. Click the icon, enter the constraint value, either real or symbolic, and press enter. You can press enter without typing a value to accept the system's default value.

You can click the constraint and drag it to adjust its placement on the drawing.
Radius Constraint

To specify the radius of a circle:

1. From select mode, click the circle. The circle will be highlighted as well as the icon.

2. Click the **Radius** icon, enter the constraint value, either real or symbolic, and press enter. You can press enter without typing a value to let the system insert a variable name.

You can click the constraint and drag it to adjust its placement on the drawing.

Perpendicular Constraint

Any two of lines, segments, vectors or polygon sides can be constrained to be perpendicular with these steps:

1. Select two from the line types listed above.

2. Click the **Perpendicular** icon.

The lines are redrawn and the perpendicular constraint is attached.
Angle Constraint

Any two of lines, segments, vectors or polygon sides can be constrained with an angle value or variable name with these steps:

1. Select two from the line types listed above.

2. Click the **Angle** icon.

3. Enter the constraint, real or symbolic. If you enter a real value, the lines will be adjusted to reflect the constraint.

Which Side to Constrain?

Sometimes when identifying angles, the constraint falls on the wrong one. In the example below, we wanted BDC, not BDA. Just click the cursor over the constraint arrow and drag it to the other side, then release the mouse button - done!

Note: The angular units are displayed in the lower right of the screen. Change the default Angle Mode in the **Edit / Preferences / Math Properties** menu, **Math** settings group.
Direction Constraint

Constrain any of the line types; line, line segment, vector, or polygon side, to a direction measured from the horizontal.

1. Select one of the line types listed above.
2. Click the Direction icon.
3. Enter the constraint, real or symbolic. If you enter a real value, the line will be adjusted to reflect the constraint.

Note: The angular units are displayed in the lower right of the screen. Change the default (Degrees or Radians) in the Edit / Preferences menu.

Slope Constraint

Specify a slope for any of the line types; line, line segment, vector, or polygon side.

1. Select one of the line types listed above.
2. Click the Slope icon.
3. Enter the constraint, real or symbolic. If you enter a real value, the line will be adjusted to reflect the constraint.
Coordinate Constraint

You can give coordinates to any point in your drawing:

1. Select a point.

2. Click the **Coordinate** icon.

3. Enter the constraint, real or symbolic. If you enter a real value, the line will be adjusted to reflect the constraint, even if the coordinate axes are not displayed.

To change the coordinates shown, double click and type over the highlighted value in the data entry box.

Constraining Vector Coeffecients

You can specify coefficients for a vector with the following steps:

1. Select a vector.

2. Click the coefficients icon.

3. Enter the coefficients separated by a comma.

Note: Don't forget the parentheses or an error message appears.
Tangent Constraint

Any of the line types; line, line segment, vector, or polygon side can be made tangent to a circle or locus with these steps:

1. Select a line of the types listed above and the circle or locus.

2. Click the **Tangent** icon from the **Constrain** tool box or select **Tangent** from the **Constrain** menu.

The line and curve immediately become tangent.

Incident Constraint

Constrain a point to be incident to any other geometry; line, segment, vector, polygon side, circle or locus with these steps:

1. Select the point and the other geometry listed above.

2. Click the **Incident** icon from the **Constrain** toolbox, or select **Incident** from the **Constrain** menu.

The point is moved to meet the line or curve, or the extension of the line. Below is an example of the latter, point D is moved to lie on the extension of line segment AB.
If you select the point or the line, incidence is indicated by a bowtie around the point:

**Congruent Constraint**

Constrain two or three of any of these geometry types: line segments, vectors, or polygon sides, to be congruent with these steps:

1. Select two line segments.

2. Click the **Congruent** icon from the **Constrain** toolbox, or select **Congruent** from the **Constrain** menu.
You will see matching congruency lines on the selected segments and a length will be adjusted.

**Parallel Constraint**

Any two or three of the linear geometry types can be made parallel: line, segment, vector, or polygon side.

1. Select two or three from the types listed above.

2. Click the **Parallel** icon from the **Constrain** toolbox, or select **Parallel** from the **Constrain** menu.

The geometry will be adjusted and matching symbols appear on the selected lines.
Implicit Equation Constraint

You can use symbolic variables to constrain geometry with an implicit equation. Lines, line segments, polygon sides, vectors and circles and conics can all be constrained with implicit equations.

1. Select the geometry.

2. Click the Implicit Equation icon from the Constrain toolbox, or select Implicit Equation from the Constrain menu.

An input window will open next to the geometry you selected. Highlighted in the window is a generic equation for the selected object; for a line, an equation like $-X_1+Y_1+C_1 = 0$ might appear. You can edit the equation with different variable names or coefficients as you like. You will find these variables added to the variable list in the Variables toolbox.

Point Proportional Along a Curve Constraint

A point proportion $t$ along a curve is defined variously for different types of curves as follows:

- For a **Line segment** $AB$, it defines the point $(1-t)\cdot A + t\cdot B$
- For a **Circle** it defines the point on the circle which subtends angle $t$ at the center.
- For a **Locus** or envelope, it defines the point at parameter value $t$.
- For general **Cartesian** functions, it defines the $x$ value of the point on the function.
• For **Polar** functions, it defines the point on the function which subtends angle $t$.
• For general **Parametric** functions, it defines the point at parameter value $t$.
• For an **Ellipse** of the form $X^2/a^2 + Y^2/b^2 = 1$ it defines the point $(a \cos(t), b \sin(t))$.
• For a **Parabola** of the form $Y = X^2/4a$ it defines the point $(2at, at^2)$
• For a **Hyperbola** of the form $X^2/a^2 - Y^2/b^2 = 1$ it defines the point $(a/\cos(t), (b \sin(t))/\cos(t))$.

1. Select a point and one of the curves mentioned above.

2. Click the **Point Proportional** icon from the **Constrain** toolbox, or select **Point Proportional** from the **Constrain** menu.

3. Enter the parameter or quantity (symbolic or real) in the data entry box.

For example, in the following diagram, D is defined proportion $t$ along AB, and E is defined proportion $t$ along BC. The curve is the locus of F as $t$ varies between 0 and 1.
In the following example, the curve is the locus of the point \((x,x^2)\). Tangents are created at points with parameter values \(x_0\) and \(x_1\) on this curve.

\[
\begin{pmatrix}
x_0 \cdot 2 \cdot t \cdot x_0 + t^2 \cdot x_0 + t \cdot x_1 + t^2 \cdot x_1 + t^2 \cdot x_2 \\
y_0 \cdot 2 \cdot t \cdot y_0 + t^2 \cdot y_0 + t \cdot y_1 + t^2 \cdot y_1 + t^2 \cdot y_2
\end{pmatrix}
\begin{pmatrix}
1 - t + t^2 \\
1 - t + t^2
\end{pmatrix} \Rightarrow
\]
Where is Point proportional along curve for conics?

The best way to understand the location of Point proportional along curve command for conics is to see how we construct it geometrically for each conic:

**Ellipse**
The ellipse with foci A and B is inscribed in circle, center M. Draw the radius MN at angle $t$ to the major axis and drop the segment NO perpendicular to the major axis of the ellipse. When the intersection of NO with the ellipse (point C) is constrained to be $t$ proportional along the ellipse, it's coordinates will be $(a \cos(t), b \sin(t))$. 
Parabola

C lies on the parabola and BC is perpendicular to the axis AB of the parabola. Point D is located proportion $t$ along the segment. Point F is the intersection of the perpendicular to BC through D with the parabola. It has the coordinates $(2at, at^2)$ when it is constrained to parametric location $t$ on this parabola.

Hyperbola

CD is the perpendicular projection of C onto the axis of the hyperbola, GF is the circle centered at the center of the hyperbola which goes through the intersections of the hyperbola with its axis. H is the point of contact of this circle with the tangent from D. We can see that the angle DGH is the same as the parameter value. When point C is constrained to be at parametric location $t$ along the curve, its coordinates are $(a/cos(t), b \sin(t)/cos(t))$ on this hyperbola.
Constructions

Creating Constructions

After sketching and constraining your drawing there are a whole set of constructions that can be applied to the geometry. First you must select the geometry elements which pertain to the construction. When you select the geometry the appropriate constructions will be highlighted.

The following table lists the **Constructions**, their icons, and which elements must be preselected to activate the constructions. Be careful when selecting geometry objects, if extra things are selected that are not related to the construction, the construction icons will remain inactive. This can happen by mistake, especially when using the selection box tool.
<table>
<thead>
<tr>
<th><strong>Construction</strong></th>
<th><strong>Preselected Objects</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Midpoint</td>
<td>A line segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Intersection</td>
<td>Two of: a line, segment, vector, polygon side or conic. Conics are limited to intersecting only with lines, segments and vectors.</td>
</tr>
<tr>
<td>Perpendicular Bisector</td>
<td>A line segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Angle Bisector</td>
<td>Two of: a line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Parallel</td>
<td>A point and one of: a line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Perpendicular</td>
<td>A point and one of: a line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Tangent</td>
<td>A circle or curve, and optionally, a point on the curve</td>
</tr>
<tr>
<td>Polygon</td>
<td>Three or more connected line segments or points (vertices) to form a polygon</td>
</tr>
<tr>
<td>Reflection</td>
<td>One or more objects</td>
</tr>
<tr>
<td>Translation</td>
<td>One or more objects</td>
</tr>
<tr>
<td>Rotation</td>
<td>One or more objects</td>
</tr>
<tr>
<td>Dilation</td>
<td>One or more objects</td>
</tr>
<tr>
<td>Locus</td>
<td>A point or line that will vary with a parameter</td>
</tr>
</tbody>
</table>
Trace | One or more objects that will vary with a parameter
---|---
Area Under Arc | An arc of a Cartesian function

### Midpoints of Line Segments

You can construct a midpoint on any line segment, vector, polygon side, or between two points by:

1. Select two from the geometry types listed above.

2. Click the **Midpoint** tool, or select **Midpoint** from the **Construct** menu.

A point will appear in the middle of the selected line.

### Intersections

You can construct a point of intersection between any of the line types in your geometry; line, segment, vector, polygon side or circle. You can also construct intersections of circles. Conics are limited to intersections only with lines, segments or vectors.

1. Select two from the line types listed above.

2. Click the **Intersection** tool, or select **Intersection** from the **Construct** menu.
A new point and label will appear at the intersection. If the lines are segments that do not intersect, a point will be created at the extension of the lines as with line segments AB and CD below.

If the geometry will never intersect, the selected objects are moved to form the intersection. In the example below, the infinite line and circle become tangent at the newly created point, H.

**Perpendicular Bisector**

You can construct a perpendicular bisector on any line, segment, vector, or polygon side with these steps:

1. Select any of the line types listed above.

2. Click the **Perpendicular Bisector** tool or select **Perpendicular Bisector** from the **Construct** menu.

An infinite line will appear at right angles to the selected line.
Geometry Expressions Manual

Angle Bisector

You can bisect the angle between any combination of line types; line, segment, vector, or polygon side with these steps:

1. Select two of any of the line types listed above.

2. Click the **Angle Bisector** tool or select **Angle Bisector** from the **Construct** menu.

An infinite line will appear between the two selected lines. You can use the Calculate / Angle tool to get the value of the bisected angle.

Parallel Constructions

You can construct a line, through a point, and parallel to another line, segment, polygon side or vector with these steps:

1. Select a point and a line of one of the types listed above.

2. Click the **Parallel** tool or select **Parallel** from the **Construct** menu.

A line is constructed which is parallel to the selected line and passes through the selected point.
Perpendicular Constructions

You can construct a line, through a point, which is perpendicular to another line, segment, polygon side or vector with these steps:

1. Select a point and a line of one of the types listed above.
2. Click the Perpendicular tool or select Perpendicular from the Construct menu.

A line is constructed which is perpendicular to the selected line and passes through the selected point.

Tangents

You can construct a line that is tangent to a circle or curve with these steps:

1. Select the circle or curve. You can also select a point on the curve so that the tangent goes through the point on the curve.
2. Click the Tangent tool or select Tangent from the Construct menu.

A line tangent to the selected curve will appear at the point where you selected the circle or curve, or at the selected point.
Polygon Construction

If you created a polygon with the line segment tool, or your polygon was not shaded for some reason, (e.g. the drawing of the sides was interrupted or out of order) you can make joined line segments into a polygon that can be selected with a single click using this construction.

1. Select the line segments that make up the polygon.

2. Click the Polygon tool in the Construct toolbox, or select Polygon from the Construct menu.

The polygon will be filled and you can now select the entire polygon with a single click.

Reflection

You can reflect any subset of your diagram about a line with these steps:

1. Select one or more geometry objects to reflect.

2. Click the Reflection tool in the Construct toolbox, or select Reflection from the Construct menu.

3. Either click the cursor to place the reflection line on the screen, adjust the angle and click again, or select an existing line as the reflection line.

A copy of your selected geometry will appear on the other side of the reflection line.
Notice all points on the reflected geometry are written as "prime", i.e. A becomes A'. If you reflect the geometry again, A' becomes A".

**Translation**

You can translate any subset of your diagram with a translation vector. Here are the steps:

1. Select the geometry to be translated.

2. Click the **Translation** tool in the **Construct** toolbox, or select **Translation** from the **Construct** menu.

3. Click the cursor to draw the end point of your translation vector and move the cursor to establish the length and angle of the translation. Click again to finish the vector.

The translated geometry appears. You can adjust the position of the translation by clicking and dragging the tip of the vector.

Notice all points on the translated geometry are written as "prime", i.e. A becomes A'. If you translate this geometry again, A' becomes A".

**Rotation**

You can rotate any subset of your diagram about a point. Here are the steps:
1. Select the geometry to be rotated.

2. Click the Rotation tool in the Construct toolbox, or select Rotation from the Construct menu.

3. Click the screen to place your rotation point.

4. In the data entry box presented, enter the angle of rotation.

The rotation of the selected geometry appears.

Notice all points on the rotated geometry are written as "prime", *i.e.* A becomes A'. If you rotate this geometry again, A' becomes A".

**Dilation**

You can dilate any subset of your diagram from a point. Here are the steps:

1. Select the geometry to be dilated.

2. Click the Dilation tool in the Construct toolbox, or select Dilation from the Construct menu.

3. Click the cursor on your dilation point.

4. In the data entry box presented, enter the dilation factor.

The dilated geometry appears.

Notice all points on the dilated geometry are written as "prime", *i.e.* A becomes A'. If you dilate this geometry again, A' becomes A".
Locus of Points / Envelope

You can construct a locus of points or envelope from a selected point or line, by defining a range for some constraint in the drawing. Just follow these easy steps:

1. Select the point on the drawing that will form the locus (point B in the example below); select a line, line segment, or vector to form an envelope.

2. When you click the Locus icon, the Edit Locus dialog pops up.

3. You need a parameter to drive the motion to create the locus. Click the arrow key to the right of the Parametric Variable window to select from a list of all variables in the drawing. (If you entered the needed constraint in real terms, Cancel the trace and change the constraint to a variable by double-clicking it in the drawing window.)

4. Simply fill in the values for the appropriate variable and click the Ok button.
Note: The locus only works if the figure's position is fixed i.e. a point in a triangle will not work as a locus unless the location of the other two points are fixed with coordinate constraints.

To adjust the range of the locus, double-click the locus to edit the dialog.

The following example shows an envelope of the line DE. We use the Point proportional along curve constraint and the parameter $t$ to position the points D and E (D is $(1-t)$ along line AC and E is $t$ along line AB). In the Edit Locus dialog, we create the envelope from parameter $t$ as it ranges from 0 to 1.
You can replay the creation of the envelope with the Animation tools. Select variable t and click the Play button.

**Trace**

You can **Trace** the movement of one or a group of drawing objects. You can create string art drawings and see how an envelope curve is formed. Here are the steps:

1. Select the drawing objects to be traced.
2. Click the **Trace** tool and the **Edit Trace** dialog pops up.
3. You need a parameter to drive the motion of the trace. Click the arrow key to the right of the **Parametric Variable** window to select...
from a list of all variables in the drawing. (If you entered the needed constraint in real terms, Cancel the trace and change your constraint to a variable by double-clicking it in the drawing window.)

4. Simply fill in the values for the appropriate variable and click the OK button.

To adjust the range or number of traces, double-click one of the traces to edit the dialog.
Area Under the Arc

The **Area Under Arc** function is found only in the **Construct** menu at the top of the main window. Here are the steps:

1. Select an arc drawn over a function.
2. Select **Construct / Area Under Arc**.

A filled area is created between the arc and the X axis. The necessary lines and points containing the area are automatically added.

Drag the handles of the original function and the area under the curve changes accordingly.
This is a great way to illustrate the definite integral.

**Note:** this only works for arcs drawn on functions. For arcs drawn on conics, create the sides with the **Draw / Line Segment**, select all sides and use the **Construct / Polygon** tool. See also: instructions for creating curvilinear polygons.

### Integral Calculus

The **Area Under Arc** function is a great way to show problems with the definite integral.

Here are the steps for making the integral of the generic function $f(x)$ over the interval $a$ to $b$:

1. Select the **Draw / Function** tool and enter $f(x)$ in the Y= data entry box. Click **OK**.
2. Use the **Draw / Arc** tool to trace over some portion of the function.
3. Select the new arc - be careful not to select the whole function. Just the section of arc should be highlighted.
4. Choose **Area Under Arc** from the **Construct** menu. The area between the arc and the X axis will be filled.
5. For each endpoint of the arc, use the **Constrain / Point proportional along curve** tool to define the limits of the region, e.g.
select $\alpha$ and $\beta$ from the **Symbols** toolbox.

6. Select the area under the arc and click **Calculate / Symbolic / Area**.

---

**Annotations**

**Applying Annotations**

Annotations allow you to add constraint information to your drawing which isn’t needed for it's construction. These might be constraints that cause the geometry to be over constrained, but you might want to give the viewer some additional information. This feature can be very helpful for making up texts or worksheets.

**Annotate** tools are similar to **Text** in that they have no influence on the geometry engine, even though they are placed exactly like the **Constrain** tools.

Since annotations may look identical to constraints, use the icon from icon bar at the top of the window to **Distinguish Constraints** /
Annotations. The icon is a toggle; to turn off the marks, click it again.

The Symbols and Annotation Symbols toolboxes are both available to the Annotate tools.

Here are the Annotate tools and the object(s) to preselect:

<table>
<thead>
<tr>
<th>Annotation</th>
<th>Preselected Object(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance / Length</td>
<td>A line segment, vector, or polygon side, or a point and one of these line types (perpendicular distance), or two points.</td>
</tr>
<tr>
<td>Radius</td>
<td>Circle</td>
</tr>
<tr>
<td>Perpendicular</td>
<td>Two of any line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Angle</td>
<td>Two of any line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Direction</td>
<td>A line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Slope</td>
<td>A line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Coordinates</td>
<td>Point</td>
</tr>
<tr>
<td>Coefficients</td>
<td>Vector</td>
</tr>
<tr>
<td>Congruent</td>
<td>A line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Congruent Angle</td>
<td>Two of any lines, segments, vectors, or polygon sides</td>
</tr>
<tr>
<td>Parallel</td>
<td>A line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Expression</td>
<td>[none]</td>
</tr>
</tbody>
</table>
Distance / Length Annotation

Length annotations may be applied to any line, segment, polygon side or vector. Distance annotations are available between two points, or the perpendicular distance between a point and a line, segment, polygon side, or vector. Use these steps:

1. Select the line segment, or point and line, or pair of points as described above. When you make your selection, the drawing objects will be highlighted and the Distance / Length icon will light up.

2. Click the icon.

3. Enter the distance information. There are no format restrictions. You can use Symbols and Annotation Symbols in the entry. Press enter when you're done.

You can click the annotation and drag it to adjust its placement in the drawing.

Radius Annotation

To annotate a circle's radius use these steps:

1. Select the circle. The Annotate / Radius icon will light up and the circle will be highlighted.

2. Click the icon.

3. Enter the radius information. There are no format restrictions. You can use Symbols and Annotation Symbols in the entry. Press enter...
when you're done.

You can click the annotation and drag it to adjust its placement in the drawing.

**Perpendicular Annotation**

The perpendicular annotation inserts the perpendicular mark between any two of these line types: line, segment, polygon side or vector. Use these steps:

1. Select two of any line, segment, vector, or polygon side. The **Annotate / Perpendicular** icon will light up when both lines are highlighted.
2. Click the icon.

Note: Placing this annotation between two lines does not change the relative position of the lines or prevent the lines from changing their relative position as it does with the **Constrain** tool of the same name.

This annotation is very useful if you are displaying a 3-d object. In this example we imported the Triangular Prism from the **Solids** folder in the Figure Gallery.
**Angle Annotation**

To annotate an angle use these steps:

1. Select two of any line, segment, vector, or polygon side. The **Annotate / Angle** icon will light up and the lines will be highlighted.

2. Click the icon

3. Enter the angle information. There are no format restrictions. You can use Symbols and Annotation Symbols in the entry. Press enter when you’re done.

**Which Side to Annotate?**

Sometimes when identifying angles, the annotation falls on the wrong one. In the example below, we wanted BDC, not BDA. Just click the cursor over the annotation arrow and drag it to the other side, then release the mouse button - done!
Direction Annotation

To annotate a line's direction use these steps:

1. Select a line, segment, vector, or polygon side. The Annotate / Direction icon will light up and the line will be highlighted.
2. Click the icon
3. Enter the direction information. There are no format restrictions. You can use Symbols and Annotation Symbols in the entry. Press enter when you're done.

You can click the annotation and drag it to adjust its placement in the drawing.

Slope Annotation

To annotate a line's slope use these steps:

1. Select a line, segment, vector, or polygon side. The Annotate /
**Slope** icon will light up and the line will be highlighted.

2. Click the icon

3. Enter the slope information. There are no format restrictions. You can use Symbols and Annotation Symbols in the entry. Press enter when you're done.

You can click the annotation and drag it to adjust its placement in the drawing.

**Coordinate Annotation**

To annotate an point's coordinates use these steps:

1. Select point. The **Annotate / Coordinate** icon will light up and the point will be highlighted.

2. Click the icon

3. Enter the coordinate information. There are no format restrictions. You can use Symbols and Annotation Symbols in the entry. Press enter when you're done.

You can click the annotation and drag it to adjust its placement in the drawing.

**Coefficients Annotation**

To annotate a vector's coefficients use these steps:
1. Select \( \vec{v} \) vector. The **Annotate / Coefficients** icon will light up and the vector will be highlighted.

2. Click the icon

3. Enter the vector's coefficients. There are no format restrictions. You can use Symbols and Annotation Symbols in the entry. Press enter when you're done.

You can click the annotation and drag it to adjust its placement in the drawing.

**Congruent Annotation**

Place a congruent mark on any of the linear drawing elements: lines, segments, vectors, or polygon sides. Use these steps:

1. Select any line, segment, vector, or polygon side. The **Annotate / Congruent** icon will light up when both lines are highlighted.

2. Click the icon.
Note: Placing this annotation on lines does not change the relative lengths of the lines or keep them the same length as it does with the **Constrain** tool of the same name.

**Congruent Angle Annotation**

Place a congruent mark between pairs of linear drawing elements: lines, segments, vectors, or polygon sides. Use these steps:

1. Select two lines, segments, vectors, or polygon sides. The **Annotate / Congruent Angle** icon will light up when both lines are highlighted.

2. Click the icon.
You can change the arc count with these steps:

1. Select the annotation.
2. Right click to invoke the selection Context menu.
3. Select **Tic/Arc Count** from the menu and click the desired number.
Parallel Annotation

Place a parallel mark on any of the linear drawing elements: lines, segments, vectors, or polygon sides. Use these steps:

1. Select any line, segment, vector, or polygon side. The Annotate / Perpendicular icon will light up when both lines are highlighted.

2. Click the icon.

Note: Placing this annotation on lines does not change the relative position of the lines or prevent the lines from changing their relative position as it does with the Constrain tool of the same name.

Expression Annotation

The Annotate / Expression command is useful for placing a line of mathematics anywhere in your drawing.
1. Click the icon $A_x$.

2. Move the cursor to the position where you want to place the expression and click.

3. Enter the expression. There are no format restrictions. You can use Symbols and Annotation Symbols in the entry. Press enter when you're done.

You can click the annotation box and drag it to adjust its placement in the drawing.

Calculations

Calculating the Output

Geometry Expressions will make calculations in the geometry based on any constraints or constructions you have specified, or just from the sketch. Calculations can be output in Real or Symbolic terms by choosing the appropriate tab.

If you haven't supplied all of the necessary input constraints, the system inserts any missing variables automatically or, for real calculations, bases the value on the sketch.

Some calculations may take longer than you expected. If the calculation isn't immediate, you can stop it and restart it with these buttons on the tool bar.

- Stop calculations
- Start calculations.
You may want to reconsider the problem, add constraints, or just let it continue with the calculation.

The *Stop calculations* and *Start calculations* can also be found under *Calculate (Output)* menu and under the general context menu.

The table below lists all the available calculations and geometry elements which must be preselected. Be careful when selecting geometry objects, if extra things are selected that are not related to the calculation (like other calculations) the calculations will remain inactive. This can happen by mistake, especially when using the selection rectangle.

<table>
<thead>
<tr>
<th>Calculation</th>
<th>Preselected Object(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance / Length</td>
<td>A line segment, vector, or polygon side, or a point and one of these line types (perpendicular distance), or two points.</td>
</tr>
<tr>
<td>Radius</td>
<td>Circle</td>
</tr>
<tr>
<td>Angle</td>
<td>Two of any line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Direction</td>
<td>A line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Slope</td>
<td>A line, segment, vector, or polygon side.</td>
</tr>
<tr>
<td>Coordinates</td>
<td>Point</td>
</tr>
<tr>
<td>Area</td>
<td>Circle or polygon</td>
</tr>
<tr>
<td>Perimeter</td>
<td>Circle or polygon</td>
</tr>
<tr>
<td>Coefficients</td>
<td>Vector</td>
</tr>
<tr>
<td>Parametric Equation</td>
<td>A line, segment, vector, polygon side, circle, or a constructed locus.</td>
</tr>
</tbody>
</table>
Implicit Equation
A line, segment, vector, polygon side, circle, or a constructed locus.

Distance / Length Calculation

Length calculations may be obtained for any line segment, polygon side or vector. Distance calculations are available between two points, or the perpendicular distance between a point and a line, segment, polygon side, or vector. Use these steps:

1. Select the line segment, or point and line, or pair of points as described above.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Distance / Length tool in the Calculate toolbox or select Distance / Length from the Calculate menu.

Geometry Expressions displays the length, using any relevant parameters you may have specified.

Radius Calculation

Geometry Expressions will calculate the radius of any circle. Use these steps to find the radius:
1. Select a circle.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Radius tool in the Calculate toolbox or select Radius from the Calculate menu.

The equation with real or symbolic terms appears in the diagram.

**Angle Calculation**

Geometry Expressions will calculate any angle between lines in the geometry. Use these steps to find the angle:

1. Select two line types - any line, segment, vector, or polygon side.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Angle tool in the Calculate toolbox or select Angle from the Calculate menu.

The equation with real or symbolic terms appears in the diagram. You can obtain the angle's supplement by dragging the angle symbol.

**Supplementary Angles**

If it's unclear whether a calculation is requested for the angle or its supplement, you can drag the angle symbol to the correct position.

Here are some examples of playing around with supplementary angles (inputs, outputs and angle annotations all have this feature):
Select and drag to get the supplement angle:

\( \Rightarrow \pi - \theta \)

Drag the input and the output changes automatically:

\( \Rightarrow \theta - \varphi \)
Direction Calculation

Geometry Expressions will calculate the direction of lines, segments, polygon sides, or vectors with these steps:

1. Select a line type.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Direction tool in the Calculate toolbox or select Direction from the Calculate menu.

The direction measurement appears in real or symbolic terms.

Slope Calculation

Geometry Expressions will calculate the slope of lines, segments, polygon sides, or vectors with these steps:

1. Select a line type.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Slope tool in the Calculate toolbox or select Slope from the Calculate menu.

The equation for the slope with real or symbolic terms appears in the diagram.
Calculate Coordinates

You can calculate the coordinates of any point in your diagram with these steps:

1. Select a point.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Coordinates tool in the Calculate toolbox or select Coordinates from the Calculate menu.

The real or symbolic coordinates appear by the point.

Area Calculation

You can obtain the area of any polygon or circle in your diagram. Note: If your polygon is not filled it is just a group of line segments. To convert them to a polygon, use the Polygon Construction tool, then proceed with these steps:

1. Select a circle or polygon.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Area tool in the Calculate toolbox or select Area from the Calculate menu.

The area is displayed in real or symbolic terms.
Perimeter Calculation

You can obtain the perimeter of any polygon or circle in your diagram. Note: If your polygon is not filled it is just a group of line segments. To convert them to a polygon, use the Polygon Construction tool, then proceed with these steps:

1. Select a circle or polygon.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Perimeter tool in the Calculate toolbox or select Perimeter from the Calculate menu.

The perimeter is displayed in real or symbolic terms.

Calculate Coefficients

Use this tool to calculate the coefficients of a vector in the diagram with these steps:

1. Select a vector.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Coefficients tool in the Calculate toolbox or select Coefficients from the Calculate menu.

The real or symbolic coefficients appear by the vector.
Calculating Parametric Equations

Computes parametric equations for a locus or envelope, based on the parameter defining the curve.

You can also calculate parametric equations for a circle or line.

Use these steps:

1. Select any geometry object described above.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Parametric Equation tool in the Calculate toolbox or select Parametric Equation from the Calculate menu.

The real or symbolic equations for x and y appear by the geometry.

Calculating Implicit Equation

Calculates the implicit equation for the selected circle or a line.

Geometry Expressions will also attempt to calculate the equation of a locus or envelope curve.

1. Select any geometry object described above.
2. Click the tab to switch from Real to Symbolic output or vice versa.

3. Click the Implicit Equation tool in the Calculate toolbox or select Implicit Equation from the Calculate menu.

The real or symbolic equation appears by the geometry.

Output

<table>
<thead>
<tr>
<th>Output</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Assumptions</td>
<td>False</td>
</tr>
<tr>
<td>Use Intermediate Variables</td>
<td>False</td>
</tr>
<tr>
<td>Show Intermediate Variables</td>
<td>True</td>
</tr>
<tr>
<td>Show Name</td>
<td>True</td>
</tr>
<tr>
<td>Show System Variables</td>
<td>False</td>
</tr>
<tr>
<td>Maximum Size Allowed On Diagram</td>
<td>2</td>
</tr>
</tbody>
</table>

Viewing the Output

The Output settings apply to Symbolic Calculations. The general default Output settings are found in the Edit / Preferences menu selection, Math tab.

Individual outputs can be adjusted in the Display Properties dialog. Select the output(s), then invoke the dialog in one of two ways:

- right click the mouse and select All Properties from the Selection context menu
from the menu bar, select **Edit / Properties**

The **Output** selections specify how the calculations are made and how the output is displayed.

- **Use Assumptions** - applies to equations containing absolute values.
- **Use Intermediate Variables** - can sometimes simplify the output.
- **Show in Output Window** - hides the output from the output window.

The "Show" check boxes control where the output is displayed.
Click the **Output** selection, and then the drop-down arrow \(\downarrow\) to select the desired state - True or False.

**Assumptions**

With the **Use Assumptions** selection, *Geometry Expressions* eliminates the absolute value from expressions and determines from the diagram whether the value is positive or negative. Try it with these steps:

1. select \(\square\) one or more output calculations
2. right click the mouse and select **All Properties** from the **Selection** context menu
3. click anywhere on the **Use Assumptions** line in the **Output** box
4. click the drop-down arrow \(\downarrow\)
5. select **False** or **True**

Obviously, this tool only has an effect when the expression selected contains an absolute value.

**Intermediate Variables**

Substituting intermediate variables can sometimes simplify expressions calculated by the program. Try this option to see how it affects your output:

1. select \(\square\) one or more output calculations
2. right click the mouse and select **All Properties** from the **Selection** context menu
3. click anywhere on the **Use Intermediate Variables** line in the **Output** box
4. click the drop-down arrow \(\downarrow\)
5. select **False** or **True**

If **Use Intermediate Variables** is False, the **Show Intermediate Variables** is
inactive.

Note: Intermediate variables are not always used in calculations, in which case this box will have no effect.

**Show Output Check Boxes**

After you generate an output expression:
1. click the output
2. right click the mouse and select **All Properties** from the **Selection** context menu
3. click one of the **Output / Show...** rows
4. click the drop-down arrow
5. select **False** or **True**

**Show Intermediate Variables** - if the system uses intermediate variables, their definitions are displayed in the output window.

**Show Name** - is a term assigned by the system to the output. This name is $z_n$ where $n$ is the sequential number of the output.
You can change the output name by double clicking the output and entering a new name in the box.

**Show On Diagram** - puts the output expression on the diagram when True.

**Show in Output Window** - puts the output expression in the **Output Window** when True. If this value is True, then **Show Name** becomes True.

**Too Big for Diagram** - the output expression is moved to the output window when True (Show in Output Window becomes True, Show On Diagram becomes False).
Symbols

Using Symbols

The Symbols toolbox lets you easily insert Greek letters into your expressions and constraints. Click the tab to choose from lower case or upper case Greek letters.

The bottom row of buttons in the toolbox lets you insert commonly used math operations. You can either use the icons, or your type them from your keyboard:

<table>
<thead>
<tr>
<th>Symbol Icon</th>
<th>Function Call / Reserved Word</th>
</tr>
</thead>
<tbody>
<tr>
<td>sqrt</td>
<td>sqrt(value)</td>
</tr>
<tr>
<td>abs</td>
<td>abs(value)</td>
</tr>
<tr>
<td>piecewise</td>
<td>piecewise({expression1, domain1},{expression2, domain2}...,{last expression, otherwise})</td>
</tr>
<tr>
<td>pi</td>
<td>pi</td>
</tr>
</tbody>
</table>

A complete list of built-in functions is detailed below.
Inserting Greek Letters

To insert Greek letters into any variable name or expression, click the appropriate tab, **Greek Upper** (upper case letters) or **Greek Lower** (lower case letters) in the **Symbols** toolbox, and click the letters to be inserted into the data entry box.

![Greek Letters Insertion](image)

**entry highlighted**  **click the symbol press the enter key**

Multiplication & Division Editing Tools

- The **Multiplication** button inserts a multiplication symbol into the expression.
- The **Division** button makes expressions easier to enter and read.
  - From the data entry box, enter the numerator of the expression, highlight it, and then click **Division**.

![Multiplication & Division Example](image)

The cursor is then positioned in the denominator.
- If you click the **Division** button first, be sure to place the cursor in the appropriate place before typing the expression.
Square Root Editing Tool

You can enter square roots in one of these ways:

- From the data entry box, enter the expression you want inside the square root, highlight the terms, and click the **Square Root** button.
- From the data entry box, click the **Square Root** button, then highlight the 0 and type the terms.
- Use the *sqrt()* function in the data entry box.

![Square Root Example](image)

Subscript / Superscript Editor

You can enter superscripts or subscripts for variables in one of these ways:

- From the data entry box, enter the expression you want sub/superscripted, highlight the terms and click the **Subscript** or **Superscript** button.

![Subscript / Superscript Example](image)

- From the data entry box, click the **Sub/Superscript** button and type the values into the grey boxes.

Note: Make sure the cursor is positioned at the left side of the gray box before typing the sub/superscript.
• Another way to make a subscript is to use square brackets - \( A[1] = A_1 \)

**Parentheses and Absolute Value Notation**

You can add parentheses or an absolute value sign to a term in one of two ways:

• From the data input box, type the term(s), highlight the term(s), then click the **Parentheses** or **Absolute Value** button.

```
(\text{x+y}) \Rightarrow \text{(x+y)}
```

• From the data entry box, click the **Parentheses** or **Absolute Value** button first and enter the terms.

**Using the Piecewise Function**

A piecewise function or expression can be created using the **Piecewise** symbol or the built-in function - \( \text{piecewise} \{ \text{expression1, domain1} \}, \{ \text{expression2, domain2} \}..., \{ \text{last expression, otherwise} \} \). The reserved word, "otherwise" is an option available for the last condition.

For details see Piecewise Function and Piecewise Parametric Example in the Creating Functions section.

**Built-In Functions**

For including in any expression or constraint, \( Gx \) has the following common functions available:

**Trig**

- \( \sin() \)
- \( \arcsin() \)
- \( \sinh() \)
Math

- **cos()**
- **arccos()**
- **cosh()**
- **tan()**
- **arctan()**
- **tanh()**

- **sqrt()** - same as $\sqrt{}$
- **abs()** - same as $\lvert \cdot \rvert$
- **signum(x)** - finds the sign of a number:
  - $-1$ if $x < 0$
  - $0$ if $x = 0$
  - $1$ if $x > 0$
- **exp(x)** - the exponential function; you must use `exp`, not $e$, $e$ is just a variable name
- **log()** or **ln()** - both mean the natural log
- **piecewise({expression1, domain1},{expression2, domain2})** - the function is evaluated in the order written
- **diff(expression, variable)**
- **integrate(expression, variable)**
- **sum(expression, variable = start, end)**
- **pi** - same as $\pi$ in the Symbols toolbox
- **ceil()** - rounds up
- **floor()** - rounds down

Boolean

- **AND**
- **OR**
- **NOT**
  - $<$
  - $\leq$
  - $>$
  - $\geq$

Using Annotation Symbols

**Annotation Symbols** are available for use with any of the **Annotate**
tools. These symbols are not used in *Geometry Expressions*’ algebra engine, but may be useful in creating worksheets and tests.

Use the symbols from the data entry window of the **Annotate** tools. Simply click the symbol you need as you type.

When you are finished with the annotation, press enter.
Font trouble - some of the Annotation Symbols may not show up in your drawing, depending on your OS and the default font setting. (Windows 7 users have no worries.) If you don't see an Annotation Symbol, change the Edit / Preferences / Math / Annotation / Font / Face Name. Try one of the Unicode fonts, e.g. Lucida Sans Unicode. If you are exporting a Metafile, you may have to change the default font in the program to which you are exporting.

System Variables and Animation
Investigating Variables

The **Variables** toolbox reports all the variables you have used in the diagram and lets you manipulate their values.
Variables List

This list contains the names of all variables used in your diagram.

For every variable name, the system shows:

- **the current value** - these values can be ones that you have explicitly specified, or just taken from the way you sketched the geometry.

- **lock status** - if the variable is locked (+) its value will not change if you move the geometry or add additional constraints; the unlocked (-) variable is free to change as the geometry moves or changes.

Functions List

When using the Function command to draw a function of the form \( Y = f(X) + g(X) \), the **Functions** tab in the **Variables** toolbox lists the functions \( f \) and \( g \) and their values. Use the edit line at the bottom of the box to modify the functions.
Using the Lock Tool

By default, when you drag points in a Geometry Expressions model, it will adjust the numerical sample values used in the various parameters of the model to accommodate the drag, as best it can.

For example, in the model of a 4 bar linkage below, dragging point B will cause lengths a and b and angle $\theta$ to be adjusted appropriately.
However, you may want the drag to act as if the members AB and BC were rigid, and only angle theta adjustable. To do this you can lock the parameters:

The value of a, for example, can still be set from the Variables panel, but it will not change when the model is dragged.
Changing and Locking the Variable Value

To make a change to the variable list, first click anyplace in the row of the variable you want to change. That row will be highlighted.

To change the value: highlight the value in the edit window and type the new value.

To change the lock status: just click the button -

- to unlock a locked variable
- to lock an open variable

Animation

Your geometry comes to life with the Animation tools. You simply need to select the parameter that drives the animation, give it a range, then Play.

In the diagram below we select $\theta$ for the crank of this linkage.
Click the headings below for details on the animation buttons and windows:

- **Animation console** - works like a video player.
- **Animation modes** - indicates how the range for the animation is stepped through.
- **Animation values and duration** - where you specify the speed and the range for the driving parameter.

Users of numeric interactive geometry systems may be familiar with the concept of animation based on points animated along line segments or curves. This type of animation can be conveniently modeled in **Geometry Expressions** using the point proportional along a curve constraint along with parameter based animation.
Animation Console

The Animation console works like a standard video console with the Play, Pause, and Stop buttons as well as advance to the Beginning and End buttons.

Animation Modes

The animation modes can be changed with the up/down arrow buttons. The modes are:

- Runs the animation one time through the specified range.
- Runs the animation continuously from the beginning to the end of the range.
- Runs the animation one time forward and then backward through the specified range.
- Runs the animation continuously forward and then backward through the specified range.

Animation Values and Duration

These animation buttons help you adjust the range and speed of the animation.

- Click and drag the slider along the bar to manually animate the drawing.
- In the two data entry windows at the bottom right and left of the toolbox, specify the range of the animation.
- The Duration box in the center lets you specify how long the animation takes to play one time through. Values are between 1 and
60 seconds.

Animation and the Locus Tool

Both the construction of the locus and envelope curves, and the animation of the diagram in Geometry Expressions can be defined in terms of any variable. For example in the model below, we can create a locus over values of the variable t (other variables will be kept constant).
Menus and Icons
Many of the menus and icons across the top of the screen duplicate the commands and functions found in the toolboxes.

### File Menu

The **File** menu contains the standard Windows file handling operations with options for copying and exporting to other programs. Several of the options are also available from the icon bar.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![New]</td>
<td>Creates a new project.</td>
</tr>
<tr>
<td>New Graph</td>
<td>Graph mode allows scaling of axes.</td>
</tr>
<tr>
<td>![Open. . .]</td>
<td>Brings up the <strong>Select a File</strong> dialog box so you can open a project.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current file or, if multiple files are open, the file on top.</td>
</tr>
<tr>
<td>![Save]</td>
<td>Saves the file. If you have not yet saved the current work to a file, the <strong>Save File As</strong> dialog box lets you specify where to save the project file.</td>
</tr>
<tr>
<td>Save As . . .</td>
<td>Brings up the <strong>Save File As</strong> dialog box to enter a new or different path / file name. Useful for making a backup.</td>
</tr>
<tr>
<td>Open Workbook</td>
<td>Brings up the <strong>Open Workbook</strong> dialog box. If any other files are open, they will be closed when you select the workbook.</td>
</tr>
<tr>
<td>Save Workbook</td>
<td>Saves all tabbed pages as a single workspace (.gxw), so you can open them all at once.</td>
</tr>
<tr>
<td>Save Workbook as</td>
<td>Saves all tabbed pages as a single workbook</td>
</tr>
</tbody>
</table>
Menus and Icons

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(.gxw) and lets you specify a new or different path / file name for the workbook.</td>
<td></td>
</tr>
<tr>
<td>Close Workbook</td>
<td>Closes the current workbook. If you have made changes to pages, you will be asked if you want to save them individually (.gx files).</td>
</tr>
<tr>
<td>Import Figure from Figure Gallery</td>
<td>A shortcut containing common geometry figures that you may need for creating worksheets or other documents.</td>
</tr>
<tr>
<td>Import GX File from Geometry Atlas</td>
<td>Import one of the many interesting theorems and problems already constructed. Browse through the files and select one to explore.</td>
</tr>
<tr>
<td>Export</td>
<td>Export the file as Windows Metafile (.emf) (Windows version only), image file, an Encapsulated PostScript (.eps), HTML file (.html), animated gif, JavaScript file, Lua app, or OS X Dashboard Widget.</td>
</tr>
<tr>
<td>Page Setup. . .</td>
<td>Displays the page setup dialog box for choosing a printer and print options.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays the printout by pages.</td>
</tr>
<tr>
<td>Print. . .</td>
<td>Displays the standard system Print dialog.</td>
</tr>
<tr>
<td>Recent files</td>
<td>Click to display a list of the most recently used files. Selecting one opens it.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the program, after prompting for save.</td>
</tr>
</tbody>
</table>

Importing Files from the Figure Gallery

Are there figures which you need to use frequently? The Figure Gallery makes your tasks easier. Browse through the folders to see the many objects, graphs and transformation examples which you can use and tailor to your needs without starting from scratch.

Figure Gallery database file is copied to your computer when you install
Geometry Expressions.

Here are the steps to import a figure:

1. Select **File / Import Figure from Figure Gallery**

2. Double click a folder or sub-folder (or click and press Select in the lower right corner) to view the problems in a category. You can also use the search window to find files.

3. Double click a problem (or click and press Select) to see an enlarged view

4. Click the Import button (it replaces the Select button in the lower right corner) to bring the drawing into your drawing window.

Use the **Toggle Hidden** function from the general context menu to modify constraints in the drawing, or try dragging the geometry to suit your needs. Don't forget to **Save**.
Navigating the Figure Gallery

The **Figure Gallery** is arranged in the usual tree structure containing folders and sub-folders.

![Image of Figure Gallery](image)

- **Back** - takes you up one level.
- **Home** - takes you to the top level.

Use the **Search** window to find a specific file or types of files. Enter the search word(s) and click **Go**.

Text at the top center of the dialog tells you which level is displayed. Click **Home** to return to the top level.

Importing Files from the Geometry Atlas

The **Geometry Atlas** is a huge collection of interesting theorems and problems which are already constructed, waiting for you to discover their mysteries. You just need to have internet access.
Browse through the atlas, organized in the usual tree structure by geometry element. Here are the steps:

1. Make sure your computer is on-line.

2. Select **File / Import GX File from Geometry Atlas**.

3. Double click a folder or sub-folder (or select the folder and press the **Select** button) to view the problems or sub-folder.

4. Double click a problem (or select the problem and press **Select**) to see an enlarged view.

5. Click the Import button to bring the drawing into your drawing window.

**Browsing the Atlas**

takes you up one level.
takes you to the top level.

Use the Search window to find a specific file or types of files. Enter the search word(s) and click Go.

Text at the top center of the dialog tells you which level is displayed. Click Home to return to the top level.

Exporting a Drawing

To export your drawing to another program, choose File / Export. You can export the drawing in the following formats:
Static File Formats

- Image - BMP, JPEG, TIFF, PNG, XMP
- Encapsulated Postscript
- Windows Enhanced Metafile
- Scalable Vector Graphics
- HTML

Dynamic File Formats

- Animated GIF
- HTML5 / JavaScript App
- Lua App
- OS X Dashboard Widget

⚠️ Please note that neither EMF, nor EPS support semi-transparency or transparent images of any kind, thus you will get a warning message if you try to export to either of these formats and you have such an item in the document.

Here are the steps for the export as an Image file, EPS, EMF, SVG or HTML:

1. For all file types enter the Filename or click the folder icon to select the appropriate folder and file.
2. Image files and HTML files have an extra step at this point as detailed below.

3. Select the region of the drawing with the displayed cursor (click-and-drag opposite corners of the region).

Animation Files and JavaScript Files have a few more details to consider as explained below.
Exporting Image Files

When exporting image files, click the down arrow in the Save as type line to select your desired image format.

Next, set the resolution in the File DPI box. Click the down arrow and select the appropriate setting or enter a number in the window.

Exporting HTML Files

When you select **File / Export / HTML**, the **HTML Export** dialog appears.

Fill in the *Html Export Settings* with optional *Title*, *Header* and *Footer* text. The *Outputs* can be renamed to something less obscure than letters with subscripts. You can give them actual labels using real words. You can also display your output expressions in many popular CAS input formats including *Content* and *Presentation MathML*. 
Exporting Animation Files

Select **File / Export / Animation File** to produce an animated *gif*. This format is supported by many applications and will enable you to embed animations in, for example, *PowerPoint* slides and *Wikipedia* pages.

Select the directory and file name of your *gif*, and you will be presented with a dialog to choose the parameter on which the animation is based, along with various technical aspects of the animation.
Menus and Icons

File DPI - specify the resolution of the output. The higher number you use, the slower will be the process of creating and loading the animation.

Frames Per Second - if you multiply this number by the animation duration specified in the Variables toolbox, you will get the number of frames captured. For example if you are set at 10 frames per second, and the Variables toolbox specifies the duration of the animation to be 4 seconds, then 40 frames will be captured. The more frames you capture, the slower will be the animation creation process, and the longer the animation will take to load.

Number of iterations - when an animation is played (e.g. when a PowerPoint slide containing the animation is displayed), enter a number to play the animation a specific number of times, or enter 0 to play it continuously.

Variable - choose the variable that controls the animation. (All the variables in the Variables toolbox should be available). The limits of the variable defining the range of the animation should be set in the Variables toolbox.

Exporting JavaScript Files

Select File / Export / [HTML5 / JavaScript App] - to export a Geometry Expressions model as a JavaScript application (.html file), within an html page. This can then run within any web browser that supports HTML 5.

Fill out the details in the JavaScript Applet Generator dialog.

© 2013 Saltire Software
Output directory - tells Gx where to put the files. It will create a file: name.html in the specified directory. You should be able to bring name.html up in a browser to see the applet.

Applet Name - is the name of the html file.

Auto-scale - when set to True, the JavaScript applet automatically rescales the drawing when the user changes the value of one of the inputs; when set to False, you click-and-drag a rectangle around the drawing after you click Ok.

Width and Height specify the size of the drawing on the html page.
Webpage Title, Webpage Header Text, and Webpage Footer Text - enter your text for these sections of the applet.

Since header and footer text may be several lines long, you can go back and change these text boxes before you close the dialog:

- select the text entry box
- click the ... to display the dialog
- enter or edit text, then click Ok.

Note: you can insert html code into the header and footer text, e.g. to make a word in the footer text bold:

![Webpage Footer Text](image)

Inputs - lets you choose which variables the user will be able to change, what text Label identifies variable and what type of control to use.

Any variables in your Gx model may be selected as input variables in the JavaScript model. See the topic detailing UI Types below.

Outputs - lets you choose which outputs will appear in the applet, and their text Label.

See the examples below.
JavaScript Applet Example

We’ll use this Gx model, displaying the radius of an incircle to create a JavaScript Applet.

Here are the parameters we entered in the JavaScript Applet Generator dialog:

Here is the result:
Incircle Radius

What lengths make the radius an integer?

side BC 6
side AC 8
side AB 10
radius 2

What if the triangle is Pythagorean?

The exported image can be zoomed in and out using the - and + keys on the keyboard or paned around using the arrow keys. If displayed on a touch sensitive device, the app supports multi-touch features.
JavaScript Animated Applet

In this applet, we'll draw a general function, \( f(x) \) and then create its derivative at \( t \) (using the Point proportional constraint). Here is the Gx drawing:

Here are the parameters we entered in the JavaScript Applet Generator dialog:
Selecting *slider* for the UI Type of variable *t* we now have the Go/Stop button to control the animation of *t* between the ranges defined in the **Variables** panel above.
The Derivative of a Function at Point $t$

Now modify the function.

App generated by Geometry Expressions
To modify the function, simply type a new one in the edit field. A multi-line function allows more options.

Creating Lua Applets

If you have a TI-Nspire™ calculator, you can put your Geometry Expressions model on it by creating an interactive Lua app.

Variables can be adjusted from a text box or with a slider. Any points in the Geometry Expressions model constrained by variable Coordinates or a variable parameter for the Point Proportional constraint can be set as draggable points in the Lua app.

After you create your Gx model select File / Export /Lua App. Fill out the details in the Lua App Generator dialog.
Output directory - tells Gx where to put the file. It will create a file: `name.tns` in the specified directory.

Applet Name - is the name of the Lua (.tns) file.

Auto-scale - when set to True, the Lua applet automatically rescales the drawing when the user changes the value of one of the inputs; when set to False, you are prompted to click-and-drag a rectangle around the drawing after you click OK.

Inputs - lets you choose which variables the user will be able to change, what text is displayed for the variable and what type of control to use.

Any variables in your Gx model may be selected as input variables in the Lua app. See the topic detailing UI Types below.
**Outputs** - lets you choose which outputs will appear in the applet, and their text **Label**.

Any measurements which are present in the *Geometry Expressions* model may be chosen as outputs for the Lua app.

When you click **OK**, the Lua code is placed on the clipboard (and also in the file you specified), ready to paste into your *TI-Nspire Teacher Software Script Editor*.

**TI Lua Script Editor**

To make a Lua app for your *TI-Nspire*, you must have the *TI-Nspire Teacher Software* or *TI-Nspire CAS Teacher Software* installed.

Click **Insert / Script Editor / Insert Script** to display the Script Editor window.

Paste (**ctrl-V**) your clipboard contents into the window. Click **Set Script**.
The app appears in the previous window.

The exported image lets you zoom in and out using - and + keys on the keyboard or pan the image using the arrow keys.

**Creating OS X Dashboard Widgets**

*Dashboard Widgets* are very similar to *JavaScript* Applets, but they sit on the *Mac* Dashboard. Select **File / Export /OS X Dashboard Widgets**.

Fill out the details in the **OS X Dashboard Widget Generator** dialog.
Output directory - tells Gx where to put the files. It will create a folder: `name.wdgt` containing all the components of the widget.

Widget Name - is the name of the folder and the main .html file.

Auto-scale - when set to True, the Widget automatically rescales the drawing when the user changes the value of one of the inputs; when set to False, you click-and-drag a rectangle around the drawing after you click Ok.

Width and Height specify the size of the drawing in the Widget box.

Widget Title, Widget Header Text, and Widget Footer Text - enter your text for these sections.
Since header and footer text may be several lines long, you can go back and change these text boxes before you close the dialog:

- select the text entry box
- click the button to display the dialog
- enter or edit text, then click Ok.

Note: you can insert HTML code into the header and footer text, e.g. to make a word in the footer text bold:

![Widget Header Text](image)

**CSS file (optional)** - you can attach your favorite Cascading Style Sheet, without having to reproduce it every time.

**Inputs** - lets you choose which variables the user will be able to change, what text **Label** identifies the variable and what type of control to use.

Any variables in your Gx model may be selected as input variables in the Widget. See the topic detailing UI Types below.

**Outputs** - lets you choose which outputs will appear in the applet, and their text **Label**.

Any measurements which are present in the Geometry Expressions model may be chosen as outputs for the widget.

**UI Types for Applets**

JavaScript, Lua Apps and Widgets use identical Input and Output types. Here are the selections.

**Inputs**
Draggable - any points in the Geometry Expressions model constrained by variable Coordinates or a variable parameter for the Point Proportional constraint can be set as Draggable points in the JavaScript, Lua app or Widget. The point's constraint variables, however, cannot be functions or negative; only positive variables are allowed for defining draggable points. I.e., the value of the variable may very well be negative, but using \(-t\) as the point proportional parameter or \((x, 3\times x)\) as a point's coordinates prevents the point from being draggable.

Slider - takes it's range from the values specified in the Gx Animation in the Variables panel. Please note - not all browsers support sliders.

Text Box - lets you enter any numeric value for the variable.
For a function, you have the choice of a single line Text Box or a Multiline Text Box. Remember to use the JavaScript return statement in multi-line statements in JavaScript Apps or Widgets.
Note: when defining variables or functions in the edit field of JavaScript Apps or Widgets, remember that JavaScript does not use "^" to denote a power. $X^2$ must be written: `pow(X,2)`.

**Advance Button** - displays the variable Label on a button and increments the variable when clicked. Uses the range and direction from the Gx animation settings. If you used decimal values in Gx, the values are reduced to integers.

**Media Controls** - works like the Advance Button but gives you some additional options. For values within the specified range, you can:
- increment or decrement regardless of the mode setting
- jump to a specific integer value by typing (as in the Text Box mode)
- jump to the beginning or end of the range

**Timer** - this is great for making Clock Applets and smooth animations. Here are the Timer Styles:

![Timer Styles](image)

The hour, minutes and seconds are taken from your computer's clock.

**Random** - gives the specified variable a single random value within the range set in the Gx Variables tool panel. To change the variable's value to another random number click the **Reload** button.

**Outputs**

Any measurements which are present in the Geometry Expressions
model may be chosen as outputs for the JavaScript, Lua Apps or Widgets. Select True from the Show in Export line and modify the Label if needed.

<table>
<thead>
<tr>
<th>Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>z[0]</strong></td>
</tr>
<tr>
<td>Show in Export</td>
</tr>
<tr>
<td>Label</td>
</tr>
<tr>
<td><strong>UI Type</strong></td>
</tr>
<tr>
<td><strong>z[1]</strong></td>
</tr>
<tr>
<td>Show in Export</td>
</tr>
</tbody>
</table>

**UI Type** - Plain Text or Show / Hide Button which is a toggle.

**Graphing Mode**

When you need to draw a graph requiring independent scaling of the axes, select File / New Graph.

- Draw your graph.
- Click an axis - the axis will be highlighted and a circular handle appears.
- Slide the handle up and down the axis with your mouse.
Note: Many of the geometry drawing, constraint and construction tools are unavailable (grayed out) in the Graphing mode for obvious reasons related to the independent scaling of the axes.

Edit Menu

The Edit menu contains the standard Windows editing operations as well as ways of dealing with constraint conflicts and all of the program settings. Several of the options are also available from the icon bar.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
<th>When Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Reverses actions starting with the last one.</td>
<td>After any action has been taken.</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Description</td>
<td>Additional Information</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Redo</td>
<td>Reinstates actions starting with the last one that was undone.</td>
<td>After using <strong>Undo</strong></td>
</tr>
<tr>
<td>Select</td>
<td>When checked, the select mode is active.</td>
<td>Select mode is always active except when using a Drawing tool or moving or panning the drawing.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects everything in the drawing window.</td>
<td>Always</td>
</tr>
<tr>
<td>Clear Selection</td>
<td>Unselects any objects that are selected.</td>
<td>Always</td>
</tr>
<tr>
<td>Cut</td>
<td>Deletes an object, but saves it so it can be pasted somewhere else.</td>
<td>An object is selected</td>
</tr>
<tr>
<td>Copy</td>
<td>Does not delete the object, but saves it so it can be pasted somewhere else.</td>
<td>An object is selected</td>
</tr>
<tr>
<td>Copy As</td>
<td>Displays a submenu of choices for copying mathematics into other programs.</td>
<td>An expression or formula is selected</td>
</tr>
<tr>
<td>Copy Drawing</td>
<td>Copies everything in the drawing window as an Enhanced Metafile (.emf)</td>
<td>Always</td>
</tr>
<tr>
<td>Copy Region</td>
<td>Copies a section of the drawing window inside a rectangle made by dragging the cursor.</td>
<td>Always</td>
</tr>
<tr>
<td>Paste</td>
<td>Puts whatever has been cut or copied into the current drawing</td>
<td>Object(s) cut or copied</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Condition</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes whatever is selected, without saving it.</td>
<td>One or more objects selected</td>
</tr>
<tr>
<td>Arrange</td>
<td>For placing selected objects on top of (bring forward) or underneath (send backward) other objects for easier selection and viewing.</td>
<td>One or more objects selected</td>
</tr>
<tr>
<td>Send to Mathematica</td>
<td>Inputs the math to <em>Mathematica</em> when the algebra system is running in another window.</td>
<td><strong>Windows version only</strong> An output expression or formula is selected</td>
</tr>
<tr>
<td>Convert to Constraint</td>
<td>Tries to convert a selected output to an input constraint if there is no conflict with other constraints</td>
<td>An output expression is selected</td>
</tr>
<tr>
<td>Convert to Measurement</td>
<td>Converts the selected constraint into a measurement (output)</td>
<td>An input constraint is selected</td>
</tr>
<tr>
<td>Convert to Real</td>
<td>Converts a symbolic calculation to a real one</td>
<td>A symbolic output is selected</td>
</tr>
<tr>
<td>Convert to Symbolic</td>
<td>Converts a real calculation to a symbolic one</td>
<td>A real output is selected</td>
</tr>
<tr>
<td>Details. . .</td>
<td>Displays the Edit Text dialog to edit a block of text</td>
<td>A block of text is selected</td>
</tr>
<tr>
<td>Parameters. . .</td>
<td>Lets you edit the parameters of functions, loci and traces.</td>
<td>A function, locus or trace is selected</td>
</tr>
<tr>
<td>Properties. . .</td>
<td>Lets you edit the display properties of the selected object(s)</td>
<td>One or more objects of the same type are selected</td>
</tr>
</tbody>
</table>
### Preferences

| Preferences . . . | Sets the default appearance and properties for the project's drawing, text and mathematics | Always |

**NOTE:** For the Mac version, **Preferences** are found under the **Geometry Expressions** menu.

### Copying Mathematics

To copy expressions or functions into an Algebra system or another program:

- Select the math from the Diagram or the Output window.

- Select **Edit / Copy As** or right-click the selected expression to display the submenu of choices for copying expressions or functions from **Geometry Expressions** to another program.
The 2 general types of MathML are available, Content and Presentation MathML, as well as formats meeting the specific quirks of several popular Computer Algebra programs.

The TeX typesetting output gives you 3 choices in the submenu: Inline, Display, and Wikipedia. The actual TeX produced is identical, except for the delimiters which mark the start and finish of the TeX code.

There is also a general purpose String output which converts the selected math into a text string containing no special characters:

\[ \Rightarrow \sqrt{a^2+b^2-2ab\cos(\theta)} \]

is copied as > (((a)^2+(b)^2+(cos(\theta)*b*a*(-2))))^(1/2).
• Generate Source Code from Geometry Expressions in a number of different languages:

When you make a submenu selection, the selected math is copied to the Windows clipboard, ready to be pasted into the appropriate application (Ctrl+V).

Generating Source Code

You can generate computer source code from Geometry Expressions in a number of different languages.

There are two types of expression in Geometry Expressions:

• Scalar
• Vector

The source code will be in a different form depending on whether there are intermediate variables present or not.

Note that there is not much difference between the languages in the mathematical expressions they generate. The main differences are:

• C#, Java, Javascript, ActionScript, Visual Basic (.net), and Lua prefixes math functions with "Math."
• C / C++ and VBA do not use any prefix for the math functions
Each language has its own way of invoking functions. In the cases where a vector is returned from the function, the different languages work in different ways.

- In C pointers to doubles representing the x and y coordinates of the vector are passed into the function.
- In C++, Visual Basic and VBA, references to doubles representing the x and y coordinates of the vector are passed into the function.
- In C# double out parameters for the x and y coordinates of the vector are used.
- In Java, JavaScript and ActionScript, an array is passed into the function, the 0th and 1st elements of the array will acquire the x and y coordinates of the vector.

**Source Code Examples**

From the following example we’ll copy the expressions for the location of point D (a vector) and distance AD (a scalar) in our code generation.

**Scalar / No Intermediate Variables**

- Select the *distance* expression.
- Right-click and select **Copy As / Source Code / C/Objective C**
In this case the code generates a single expression (here we are generating C):

\[(\text{pow}((\text{pow}(c,2)+((a+(b*-1))*c),0.5)\text{pow}((a+b+c),-0.5)\text{pow}(a,0.5)).\]

**Scalar / Intermediate Variables**

With intermediate variables showing we get the following for the distance expression:

```c
double distance(
    double a,
    double b,
    double c)
{
    double d_1;
    double v_1;
    double phi_0;
    double d_2;
    double d_0;
    double u_1;
    d_1 =
    (\text{pow}(((a*-1)+b+c),0.5)\text{pow}((a+(b*-1)+c),0.5)\text{pow}((a+b+(c*-1)),0.5)
    *\text{pow}((a+b+c),0.5));
    v_1 = (d_1*\text{pow}(a,-1)*0.5);
    phi_0 = ((a+b+c)*v_1*\text{pow}(c,-1)\text{pow}(b,-1));
    d_2 = (v_1*\text{pow}(b,-1)*a*-1);
    d_0 = (\text{pow}(a,2)+(\text{pow}(b,2)*-1)+\text{pow}(c,2));
    u_1 = (d_0*\text{pow}(a,-1)*0.5);
    return
    (\text{pow}(\text{fabs}(phi_0),-1)\text{fabs}(d_2)\text{pow}((\text{pow}(c,2)+(u_1*c*2)+\text{pow}(u_1,2)+
    \text{pow}(v_1,2)),0.5)\text{pow}(c,1));
}
```

We see that the name of the function is the name of the expression in Geometry Expressions, its parameters are the input variables, and its return value is the value of the expression.

**Vector / Intermediate Variables**
Select the *location* expression, a vector value, and our function returns two quantities. This is done in different ways for different languages:

**C / Objective C**

Pointers to doubles are passed into the function:

```c
void location(
    double a ,
    double b ,
    double c ,
    double *location_x_ ,
    double *location_y_ )
{
    double location_x;
    double location_y;
    double d_1;
    double v_1;
    double d_2;
    double d_0;
    double u_1;
    double phi_0;
    d_1 =
        (pow(((a*1+b+c),0.5)*pow((a+(b*1)+c),0.5)*pow((a+b+(c*1)),0.5)*pow((a+b+c),0.5));
    v_1 = (d_1*pow(a,-1)*0.5);
    d_2 = (v_1*pow(b,-1)*a*1);
    d_0 = (pow(a,2)+(pow(b,2)-1)+pow(c,2));
    u_1 = (d_0*pow(a,-1)*0.5);
    phi_0 = ((a+b+c)*v_1*pow(c,-1)*pow(b,-1));
    location_x = (((d_2*1)+(u_1*d_2*pow(c,-1)*1))*pow(phi_0,1));
    location_y = (pow(phi_0,1)*v_1*d_2*pow(c,-1)*1);
    *location_x_ = location_x;
    *location_y_ = location_y;
}
```

**C++**

References are passed into the function:
void location(
    double a ,
    double b ,
    double c ,
    double &location_x_ ,
    double &location_y_ )
{
    double location_x;
    double location_y;

    ...
    location_x_ = location_x;
    location_y_ = location_y;
}

**C Sharp**
Out parameters are passed into the function:
void location(
    double a ,
    double b ,
    double c ,
    out double ... location_y_ )
{
    double location_x;
    double location_y;

    ...
    location_x_ = location_x;
    location_y_ = location_y;
}

**Visual Basic / VBA**
References are passed into the function:
Sub z_0(ByVal a As Double , ByVal b As Double , ByVal c As Double ,
ByRef z_0_x_ As Double ,ByRef z_0_y_ As Double )
    Dim z_0_x As Double
Dim z_0_y As Double

...  
    z_0_x_ = z_0_x  
    z_0_y_ = z_0_y  
End Sub

**Java**
An array of doubles of size 2 is passed in and populated by the function:
```java
double location(
    double a ,
    double b ,
    double c ,
    double[] location_v )
{
    double location_x = 0;
    double location_y = 0;
    ...
    location_v[0] = location_x;
    location_v[1] = location_y;
}
```

**JavaScript**
An array is passed in and populated by the function:
```javascript
function location(
    a ,
    b ,
    c ,
    location_v )
{
```
var location_x = 0;
var location_y = 0;

...
location_v[0] = location_x;
location_v[1] = location_y;
}

Action Script
An array is passed in and populated by the function:
public function location(
    a:Number ,
    b:Number ,
    c:Number ,
    location_v:Array) 
: void
{
    var location_x:Number;
    var location_y:Number;

    ...
    location_v[0] = location_x;
    location_v[1] = location_y;
}

View Menu

The table below lists the complete summary of View functions.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
<th>When Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide</td>
<td>Hides a selection</td>
<td>One or more elements are selected.</td>
</tr>
<tr>
<td>Show all</td>
<td>Displays any entities that were hidden</td>
<td>One or more elements are hidden.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Toggle Hidden</td>
<td>Lets you toggle hidden / visible for any object in the drawing</td>
<td>Always (if the drawing window isn't empty)</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Makes the drawing details larger without affecting the size on the printed page. (The text gets larger on the screen.)</td>
<td>Always available - (most useful when there is something in the drawing window).</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Makes the drawing details smaller without affecting the size on the printed page. (The text gets smaller on the screen.)</td>
<td>Always available - (most useful when there is something in the drawing window).</td>
</tr>
<tr>
<td>Zoom To Selection</td>
<td>Lets you make a selection and adjusts it to fit the drawing window. (The text gets larger on the screen.)</td>
<td>Always available - (most useful when there is something in the drawing window).</td>
</tr>
<tr>
<td>Zoom To Fit</td>
<td>The entire diagram is displayed in the drawing window. (The text size changes with the geometry.)</td>
<td>Always available - (most useful when there is something in the drawing window).</td>
</tr>
<tr>
<td>Zoom To Page</td>
<td>The whole page is displayed in the drawing window. (The text size changes with the geometry.)</td>
<td>Always available - (most useful when there is something in the drawing window).</td>
</tr>
<tr>
<td>Pan View</td>
<td>Allows you to move the contents of the drawing window without changing its position on the page.</td>
<td>Always available - either Pan View or Move Geometry will be in effect (checked).</td>
</tr>
<tr>
<td>Scale Geometry Up</td>
<td>Enlarges only the geometry. (The text size on the screen doesn't change.)</td>
<td>Always</td>
</tr>
<tr>
<td>Scale</td>
<td>Shrinks only the geometry. (The text size</td>
<td>Always</td>
</tr>
<tr>
<td>Geometry Down</td>
<td>on the screen doesn't change.</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------</td>
<td></td>
</tr>
<tr>
<td>Scale Geometry To Selection</td>
<td>Lets you select a portion of the geometry and adjusts it to fit the drawing window (The text size on the screen doesn't change.)</td>
<td>Always</td>
</tr>
<tr>
<td>Scale Geometry To Fit</td>
<td>Adjusts all geometry to fit in the drawing window. (The text size on the screen doesn't change.)</td>
<td>Always</td>
</tr>
<tr>
<td>Scale Geometry To Page</td>
<td>Adjusts all geometry to fit inside the specified page boundaries. (The text size doesn't change relative to the page.)</td>
<td>Always</td>
</tr>
<tr>
<td>Move Geometry</td>
<td>When checked, click and drag to move the drawing contents with respect to the page boundaries.</td>
<td>Always. Make sure <strong>Page Boundaries</strong> is checked (below) to see the results.</td>
</tr>
<tr>
<td>Axes</td>
<td>When checked, the axes are displayed. They have the properties of Infinite Lines.</td>
<td>Always</td>
</tr>
<tr>
<td>Grid</td>
<td>When checked, the grid is displayed.</td>
<td>Always</td>
</tr>
<tr>
<td>Page Boundaries</td>
<td>When checked, the page boundaries are displayed.</td>
<td>Always</td>
</tr>
<tr>
<td>Tool Panels</td>
<td>Lists all the toolboxes. When checked, the toolboxes are displayed on the screen.</td>
<td>Always</td>
</tr>
<tr>
<td>Tool Panel Configurations</td>
<td>Gives you options for arranging the toolboxes to your preference.</td>
<td></td>
</tr>
</tbody>
</table>
Output | When checked, the output window is displayed. | Always
---|---|---
Language | The current version of Geometry Expressions can be displayed in English, French, German, Spanish, Polish, or Russian. Choose one and restart the program. | Always

Checked menu options are toggles:
- Checked indicates the option / mode is active or displayed.
- Unchecked indicates the option / mode is inactive or hidden.
- Except Pan View and Move Geometry where one or the other is checked.

Click the selection to change its state.

Some menu items have icon shortcuts found on the icon bar at the top of the screen.

**Zooming and Scaling**

The View menu has Zoom operations pertaining to the screen view, and Scale operations pertaining to the page view.

- Zooming makes the drawing details smaller without affecting the size on the printed page. The text (constraints, output and annotation) changes size with the rest of the drawing.
- Scaling adjusts the size of the geometry relative to the page, but the text doesn't change size in the drawing window. Check View / Page Boundaries to see this work.

The Scale functions used from the icon bar at the top of the screen can be changed to Zoom functions by holding the ctrl key while clicking the icon. This is handy if you need to change the size of the text on the screen:

- A Scale down followed by a Zoom in [ctrl] has the effect
of enlarging the text.

- A **Zoom out** [ctrl] followed by a **Scale up** has the effect of shrinking the text on the screen.

## Toolbox Menus

The menus with the same name as the toolboxes at the side of the screen just give another way of accessing the same functions.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Draw</strong></td>
<td>Point</td>
</tr>
<tr>
<td></td>
<td>Line Segment</td>
</tr>
<tr>
<td></td>
<td>Infinite Line</td>
</tr>
<tr>
<td></td>
<td>Vector</td>
</tr>
<tr>
<td></td>
<td>Polygon</td>
</tr>
<tr>
<td></td>
<td>Circle</td>
</tr>
<tr>
<td></td>
<td>Ellipse</td>
</tr>
<tr>
<td></td>
<td>Parabola</td>
</tr>
<tr>
<td></td>
<td>Hyperbola</td>
</tr>
<tr>
<td></td>
<td>Arc</td>
</tr>
<tr>
<td></td>
<td>N-gon</td>
</tr>
<tr>
<td></td>
<td>Curve Approximation</td>
</tr>
<tr>
<td></td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td>Picture</td>
</tr>
<tr>
<td></td>
<td>Expression</td>
</tr>
<tr>
<td></td>
<td>Function</td>
</tr>
<tr>
<td><strong>Annotate</strong></td>
<td>Angle</td>
</tr>
<tr>
<td></td>
<td>Distance / Length</td>
</tr>
<tr>
<td></td>
<td>Coefficients</td>
</tr>
<tr>
<td></td>
<td>Coordinate</td>
</tr>
<tr>
<td></td>
<td>Radius</td>
</tr>
<tr>
<td></td>
<td>Expression</td>
</tr>
<tr>
<td></td>
<td>Direction</td>
</tr>
<tr>
<td></td>
<td>Slope</td>
</tr>
<tr>
<td><strong>Constrain</strong></td>
<td>Distance / Length</td>
</tr>
<tr>
<td></td>
<td>Radius</td>
</tr>
<tr>
<td></td>
<td>Perpendicular</td>
</tr>
<tr>
<td></td>
<td>Angle</td>
</tr>
<tr>
<td></td>
<td>Direction</td>
</tr>
<tr>
<td></td>
<td>Slope</td>
</tr>
<tr>
<td></td>
<td>Coordinate</td>
</tr>
<tr>
<td></td>
<td>Coefficients</td>
</tr>
<tr>
<td></td>
<td>Tangent</td>
</tr>
<tr>
<td></td>
<td>Incident</td>
</tr>
<tr>
<td></td>
<td>Congruent</td>
</tr>
<tr>
<td></td>
<td>Parallel</td>
</tr>
<tr>
<td></td>
<td>Equation</td>
</tr>
<tr>
<td></td>
<td>Proportional</td>
</tr>
<tr>
<td><strong>Construct</strong></td>
<td>Midpoint</td>
</tr>
<tr>
<td></td>
<td>Intersection</td>
</tr>
<tr>
<td></td>
<td>Perpendicular Bisector</td>
</tr>
</tbody>
</table>
Angle Bisector | Parallel | Perpendicular
--- | --- | ---
Tangent to Curve | Polygon | Reflection
Translation | Rotation | Dilation
Locus | Trace | Area Under Arc
**Calculate**
Distance / Length | Radius | Angle
Direction | Slope | Coordinates
Area | Perimeter | Coefficients
Parametric Equation | Implicit Equation
Stop Calculations | Start Calculations

**Help Menu**

The **Help** menu lets you access this help system, check for updates, change the program's language, and gives you information about the program's license and version.

The menu selections are always available.

<table>
<thead>
<tr>
<th><strong>Menu Option</strong></th>
<th><strong>Function</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Help</td>
<td>Invokes the Help system</td>
</tr>
<tr>
<td>Contents. . .</td>
<td>Look in the Table of Contents; add new or refer to saved bookmarks.</td>
</tr>
<tr>
<td>Index. . .</td>
<td>Look in the <strong>Help</strong> index. There is also a facility to <strong>Search</strong> index headings.</td>
</tr>
<tr>
<td>Search. . .</td>
<td>Search the <strong>Help</strong> topics for keywords.</td>
</tr>
<tr>
<td>License. . .</td>
<td>Displays information about your license.</td>
</tr>
</tbody>
</table>
Check for Updates... Prompts you to save your work, checks for new versions of Geometry Expressions, then restarts the program.

About... Contains the current version of the program, the copyright notice, and the link to Geometry Expressions' website.

NOTE: For the Mac version, About... is listed under Geometry Expressions menu.

Context Menus

Context Menus pop up when you right-click with the cursor positioned anywhere in the drawing window.

- The general context menu - appears when you right click and nothing is selected.
- The selection context menu - appears when one or more elements in the drawing window are selected. Some menu entries may be inactive, depending on which elements are selected.

The General Context Menu

Right-click anywhere in the drawing window to display a context menu. If nothing in the window is selected, the menu choices are the following:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
<th>When Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Closes the current file</td>
<td>Always</td>
</tr>
<tr>
<td>Save</td>
<td>Updates a file that already exists</td>
<td>The file has been saved</td>
</tr>
<tr>
<td>Save As. ...</td>
<td>Saves a file for the first time and prompt for the filename and path</td>
<td>Always</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects everything in the drawing window</td>
<td>Always</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Copy Drawing</td>
<td>Copies everything in the drawing window as an Enhanced Metafile (.emf)</td>
<td>Always</td>
</tr>
<tr>
<td>Copy Region</td>
<td>Copies a section of the drawing window inside a rectangle made by dragging the cursor.</td>
<td>Always</td>
</tr>
<tr>
<td>Paste</td>
<td>Puts whatever has been cut or copied into the current document</td>
<td>Object(s) cut or copied</td>
</tr>
<tr>
<td>Show All</td>
<td>Displays any entities that were hidden</td>
<td>One or more element(s) are hidden</td>
</tr>
<tr>
<td>Toggle Hidden</td>
<td>Lets you toggle hidden / visible for any object in the drawing</td>
<td>Always</td>
</tr>
<tr>
<td>Stop Calculations</td>
<td>Stop current calculations</td>
<td>A calculation isn't finished</td>
</tr>
<tr>
<td>Start Calculations</td>
<td>Restart any stopped calculations</td>
<td>A calculation is stopped by user</td>
</tr>
</tbody>
</table>

**Toggling - Hide / Show Elements**

From the general context menu select **Toggle Hidden**. The magic wand cursor appears, and any hidden objects appear faintly in the drawing window.
Click faint items to display them. Click any displayed items to hide them. When you are finished toggling, click the select arrow [ ].

**Selection Context Menu**

Select one or more drawing elements and right-click anywhere in the drawing window to display a context menu. Selection context menus contain some subset of the following list.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
<th>When Available</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Deletes an object, but saves it so it can be pasted somewhere else</td>
<td>One or more objects selected</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Does not delete the object, but saves it so it can be pasted somewhere else</td>
<td>One or more objects selected</td>
</tr>
<tr>
<td>Copy As</td>
<td>Displays a submenu of choices for copying mathematics into other programs</td>
<td>An expression or formula is selected</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
<td>Condition</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Send to Mathematica</td>
<td>Inputs the selected expression to <em>Mathematica</em> when the algebra system is running in another window</td>
<td>An output expression or formula is selected</td>
</tr>
<tr>
<td>Paste</td>
<td>Puts whatever has been cut or copied into the current document</td>
<td>Object(s) cut or copied</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes whatever is selected, without saving it</td>
<td>One or more objects selected</td>
</tr>
<tr>
<td>Hide</td>
<td>Makes the selected objects invisible</td>
<td>One or more objects selected</td>
</tr>
<tr>
<td>Edit Parameters...</td>
<td>Lets you edit the domain of a polar or parametric function or the parameters of a locus or trace.</td>
<td>A function, locus, or trace is selected</td>
</tr>
<tr>
<td>Arrange</td>
<td>For placing selected objects on top of (bring forward) or underneath (send backward) other objects for easier selection and viewing</td>
<td>One or more objects selected</td>
</tr>
<tr>
<td>Constrain (Input)</td>
<td>Displays a submenu identical to the one in the same drop-down menu on the <em>Menu Bar</em></td>
<td>Geometry selected</td>
</tr>
<tr>
<td>Construct</td>
<td>Displays a submenu identical to the one in the same drop-down menu on the <em>Menu Bar</em></td>
<td>Geometry selected</td>
</tr>
<tr>
<td>Calculate (Output)</td>
<td>Displays a submenu identical to the one in the same drop-down menu on the <em>Menu Bar</em></td>
<td>Geometry selected</td>
</tr>
<tr>
<td>Visibility Condition</td>
<td>Lets you enter an equation specifying when the selected object(s) are visible.</td>
<td>One or more objects selected</td>
</tr>
<tr>
<td>Point Properties</td>
<td>Lets you change the selected point's color and size</td>
<td>One or more points selected</td>
</tr>
<tr>
<td>Menu/Icon</td>
<td>Description</td>
<td>Selection Criteria</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Arrow Head</td>
<td>Lets you turn off or change the arrow head style of the selected segment(s)</td>
<td>One or more segments selected</td>
</tr>
<tr>
<td>Line Properties</td>
<td>Lets you change the selected line's color, style, and thickness</td>
<td>One or more objects created with lines or segments</td>
</tr>
<tr>
<td>Fill Properties</td>
<td>Lets you change the color, style, and transparency level of the selected object(s)</td>
<td>Polygon, N-gon, filled circle, filled ellipse, picture or trace selected</td>
</tr>
<tr>
<td>Pinned</td>
<td>Lets you pin / unpin the selected object(s)</td>
<td>Text, picture, or expression selected</td>
</tr>
<tr>
<td>Text Properties</td>
<td>Lets you change the selected text's color, size, and style</td>
<td>Text, label, expression, constraint, or measurement selected</td>
</tr>
<tr>
<td>Show Symbol</td>
<td>A toggle to display or hide the selected object(s)</td>
<td>Constraints, annotations, or measurement lines selected</td>
</tr>
<tr>
<td>Output Properties</td>
<td>Lets you turn on or off the selected output's name, assumption or intermediate variables</td>
<td>One or more outputs selected</td>
</tr>
<tr>
<td>Show Arrowheads</td>
<td>Lets you turn on or off the selected angle symbol's arrowheads</td>
<td>One or more angle symbols selected</td>
</tr>
<tr>
<td>Congruence Style</td>
<td>Lets you change the angle style from arcs to tics and vice versa</td>
<td>One or more angle or congruent angle annotations selected</td>
</tr>
<tr>
<td><strong>Tic / Arc Count</strong></td>
<td>Lets you change the number of tic/arc counts of selected annotations</td>
<td>One or more congruent, congruent angle, or parallel annotations selected</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Axes Properties</strong></td>
<td>Lets you turn the labels on the axes on/off or change the number of subdivisions or units to display</td>
<td>One or both axes selected</td>
</tr>
<tr>
<td><strong>All Properties. . .</strong></td>
<td>Lets you edit the display properties of the selected object(s)</td>
<td>One or several similar objects are selected</td>
</tr>
<tr>
<td>[Convert to Calculation (Output)]</td>
<td>Deletes the selected constraint and calculates the equivalent output</td>
<td>A constraint is selected</td>
</tr>
<tr>
<td>[Convert to Constraint (Input)]</td>
<td>Changes the calculation to an input constraint</td>
<td>An output expression is selected</td>
</tr>
<tr>
<td>[Convert to Real]</td>
<td>Changes a symbolic output to a real output value</td>
<td>A symbolic output expression is selected</td>
</tr>
<tr>
<td>[Convert to Symbolic]</td>
<td>Changes a real output value to a symbolic output expression</td>
<td>A real output value is selected</td>
</tr>
</tbody>
</table>

**Axes Display Properties**

The Axes Display can be set in the default settings, **Edit / Preferences** under the **Grid, Axis, Page** tab, or you can change them for an individual drawing from the Selection Context menu.

To invoke the **Selection Context** menu:
1. Select one or both axes
2. Right click the mouse
The **All Properties** selection brings up all the **Display Properties** dialog for the axes.

You can configure the X and Y axes in many ways. There are the usual attributes of lines and text.

**Show Labels** - is useful when the axis labels lie under some part of your diagram making it hard to read. You can turn these off on one or both axes with the attribute set to **False**.

**Units** - can be set to the usual decimal, but with trig functions you may find the **Degrees**, **Radians** or **Radians/3** units more appropriate. If you use the **Degrees** or **Radians** units in trig functions, don't forget to set your Angle Mode to **Radians** on the status bar.
Visibility Condition

You can set any mathematical condition for one or more object's visibility. Use this with the Animation tools for some great effects. Here are the steps:

1. Select the object(s) that you want to change visibility.
2. Right-click and select Visibility Condition from the Selection Context menu.
3. Enter the expression for a defined variable for which you would like
your object(s) to be visible.

Here's an example. Point C is t proportional along the parabola. In the first figure the picture is hidden. When the picture was visible, we set it's Visibility Condition to: $|t| > 0 \ AND \ |t| < 0.3$. With the Animation tools we set $t$ from -1.5 to 1.5. As point C approaches the top of the arc, BOOM!

![Image](image.png)

**Tool Bar**

The icons across the top of the screen make some of the routine tasks in the File, Edit, and View menus, and Help easily accessible.

- See **The Selection Arrow** for more information.
- See **File Menu** for more information.
- See **Edit Menu** for more information.
- See **View Menu** for more information.
- See **Output Calculations** for more information.

Invokes the embedded Help facility
More About Geometry Expressions
What's New in Geometry Expressions?

Our JavaScript Apps, Lua Apps and Dashboard Widget generation capabilities were so popular, we added several new features.  

There are new Input controls for variables -

- **Advance Button** lets you increment a variable
- **Media Button** gives you more controls to change the variable
- **Random** generates a random value within your specified range
- **Time** is handy for making clock apps and other animated apps

Outputs can now be attached to a **Show / Hide Button**. This feature combined with the **Random** input type is very handy for making practice Apps where students can check their answers by clicking an answer button, then reload the page with a new problem.

A new feature in Geometry Expressions that caries over into any generated Applet is the **Visibility Condition** which lets you show any object under a mathematical condition.

Now you are not limited to only one of **Constraints, Annotations, or Calculations** on a single object. If you like, you can have all three! So, for example, you could have an angle annotation on the supplementary angle of a constrained angle.

Other new features include:

- a new export file format, Scalable Vector Graphics (.svg)
- two new Built-In Functions - ceil() and floor(), a handy way to convert a value to an integer.
Where is the Geometry Expressions Website?

Information on upgrades, additional technical support and loads of great examples can be found on the Geometry Expressions website at: www.GeometryExpressions.com.

Can I See Some Examples?

Yes! We're on YouTube!

You can also sign up for a live Webinar. Send us a note and we'll get back to you with a date and time.
Index

- . -
  .bmp  157
  .emf  157
  .gx  32
  .gxw  32
  .jpg  157
  .png  157
  .tif  157
  .xmp  157

- 3 -
  3-D drawing  114

- A -
  absolute value notation  139
  ActionScript  183
  adjusting
drawing  74
text size  192
angle
  annotation  115
  bisector  100
  calculate  125
  constraint  85
  mode  15
  supplement  125
animation  147
  console  149
duration  149
  export file  160
  modes  149
  parameter based  150
  values  149
  with Locus tool  150
annotation  111
  angle  115
  coefficients  117
  congruent  118
  congruent angle  119
  coordinate  117
direction  116
distance  113
distinguish from constraints  77
expression  121
length  113
parallel  121
perpendicular  114
radius  113
slope  116
symbols  140
text  57
Applets  161, 169
  Inputs  174
  Multiline Text Box  168
  Outputs  176
  UI Types  174
Arcs  50
Area between curves  51
area calculation  128
area under the curve  110
assumptions  133
axes  43
display properties  200
scaling  177
units  200

- B -
  Background color  24
  bisector
    angle  100
    perpendicular  99
  built-in functions  136, 139

- C -
  C  183
  C#  183
  C++  183
calculations  122
  angle  125
  area  128
  coordinates  128
direction  127
distance / length  124
  implicit equations  130
calculation 122
parametric equations 130
perimeter 129
radius 124
slope 127
vector coefficients 129
Calculus 110
check boxes 134
circles 46
coefficients
annotation 117
constraint 87
conflicts, constraint 81
congruence 89
angle annotation 119
annotation 118
constraints 75
angle 85
changing 77
conflicts 81
congruent line segments 89
coordinate 87
direction 86
distance 83
distinguish from annotations 77
equation 91
incident 88
length 83
parallel line segments 90
perpendicular 84
point proportional along curve 91
radius 84
slope 86
system added 78
tangents 88
vector coefficients 87
constructions 96
angle bisector 100
area under arc 110
dilation 104
intersection 98
locus of points 105
midpoints 98
parallel 100
perpendicular bisector 99
perpendicular lines 101
reflection 102
rotation 103
tangent 101
trace 107
translation 103
Context Menus 195
Visibility Condition 202
Convert to
Input / Output 197
Symbolic / Real 197
coordinates
annotation 117
calculation 128
constraint 87
copy and paste mathematics 36
Copy As
mathematics 181
MathML input 181
String input 181
curve approximations 56
Curvilinear polygon 51
Dashboard Widgets 172
Defaults 28
text font 58
degrees 15
dilation 104
direction
annotation 116
calculate 127
constraint 86
Display 14
configuration 21
customizing 18
output properties 131
Settings 28
distance
annotation 113
calculate 124
constraint 83
Distinguish Constraints / Annotations 77
division editing tool 137
drawing
adjusting 74
arcs 50
circles 46
constraints 75
Index

- **E** -
  
  Edit Menu  178
  Copy As  181
  Preferences  28
  Settings  28
  Ellipse  47
  envelope  105
  Equations
    constraint  91
    implicit  91
    implicit: calculating  130
  examples  38
  exporting drawings  157
  Animation files  160
  HTML  159
  Image files  159
  JavaScript Applet animated example  166
  JavaScript Applet example  164
  JavaScript files  161
  Lua applets  169
  widgets  172
  Expression
    annotation  121
    Draw tool  60

- **F** -
  
  Figure Gallery
    controls  155
    Import  153
  File Handling  32
    workbooks & individual files  33
  File Menu  152
    Export  157
    Import from the Figure Gallery  153
    import from the Geometry Atlas  155
  functions  61
    built-in  136, 139
    cartesian  62
    domain  65, 67
    f(X)  64
    handles  62, 65, 67
    list  144
    parametric  67
    piecewise  69
    polar  65

- **G** -
  
  Geometry Atlas  155
  Graphing mode  177
  Greek letters  137

- **H** -
  
  help
    using the Help system  11
  Help Menu  194
  Hide, toggle  196
  HTML export files  159
  Hyperbola  49

- **I** -
  
  Icon Bar  203
  image export  157
  Image export files  159
  Import files
    from the Figure Gallery  153
    from the Geometry Atlas  155
  incidence  41, 88
  Input constraints  75
  integrals  110
  intermediate variables  133
  intersections  98
- J -
Java 183
JavaScript export files 161
animated example 166
example 164
using multi-line functions 166
JavaScript, Source code 183

- L -
length
  annotation 113
calculation 124
constraint 83
line
  infinite 43
  intersections 98
  parallel construction 100
  segments 42
linked text 11
locking variables 147
  using the lock 145
locus of points 105
curves and animation 150
Lua Apps 169, 171

- M -
MathML 36, 181
Menus
  Annotate 111
  Calculate (Output) 122
  Constrain (Input) 75
  Construct 96
  Context 195, 197
  Draw 40
  Edit 178
  File 152
  Help 194
  View 189
Metafile 157
midpoints 98
move the drawing 74
multiple drawings 32

- N -
New features 206
N-gons 55

- O -
Objective C 183
output
  assumptions 133
calculations 122
check boxes 134
name 134
properties 131
window 189

- P -
page tabs 32
  arranging 22
Parabola 48
parallel 90
  annotation 121
  construction 100
parametric equations
  output 130
Parametric Variable 105, 107
parentheses for math notation 139
perimeter calculation 129
perpendicular
  annotation 114
  bisector 99
  constraint 84
  construction 101
Pictures 58
Piecewise Functions 69
  parametric example 70
points 41
  constrained along a curve 91
polygons
  construction 102
drawing 45
  regular 55
Preferences 28
Properties
Properties
  Axes 200

- R -
radians 15
radius
  annotation 113
calculate 124
constraint 84
Reflection 102
reserved words 136
rotation 103

- S -
Scale 74, 192
scaling the axes 177
screen layout 14
selecting
  geometry 72
  multiple objects 73
Settings 28
show output 134
slope
  annotation 116
calculate 127
constraint 86
Smartboard Mode 74
source code 183
examples 184
square root editing tool 138
status bar 15
subscript / superscript 138
Supplementary Angles 125
symbols 136
  division 137
Greek letters 137
  parentheses & absolute value 139
square root 138
  subscript / superscript 138

- T -
tangents 88, 101
text 57

- E -
Edit Text dialog 58
  size 192

- T -
TI-Nspire
  Script Editor 171
Toolbox Menus 193
toolboxes
  arranging 19
  configuration 21
  floating / anchored 19
  hiding / showing 20
Trace 107
translation 103

- V -
variables 143
  functions list 144
  list 144
  locking 147
  value 147
VBA 183
vectors
  calculate coefficients 129
  constraints: coefficients 87
drawing 44
View Menu 189
Visibility Condition 202
Visual Basic 183

- W -
Widgets 172
Workbook files 33
workspace 32

- Z -
Zoom 74, 192